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Preface

1. Give us Feedback

If you find a typographical error, or know how this guide can be improved, we would love to hear

from you. Submit a report in JIRA against eXo Content. The following link will take you to bug report

for eXo Content http://jira.exoplatform.org [http://jira.exoplatform.org/secure/Dashboard.jspa].

Select the document name and version number relevant to the document you found the error in

from the available lists then complete the description with as much detail as you can provide.

Be sure to give us your name so that you can receive full credit for reporting the issue.

http://jira.exoplatform.org/secure/Dashboard.jspa
http://jira.exoplatform.org/secure/Dashboard.jspa
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Overall Introduction

1.1. Overview

Beginning as an Open Source project in the year 2002, eXo is well-known as the industry's first

Java portlet container. With the aim of dominating the potential portal market through robust and

easy-to-use applications, eXo Project has succeeded in attracting consumers from across the

globe. eXo has actually opened the floodgates to various options in many markets, and customers

have been choosing eXo as the best method for their success.

The eXo Platform™ software is a powerful Open Source application that incorporates portal and

content management systems. Users of the platform have a customized single point of access to

their company's information system and resources.

The foundation for eXo Platform 3.0 is eXo Core Services, a powerful set of REST-based

services for rapid website development, content management and gadget-based development.

eXo Extended Services are also a part of the eXo Platform 3.0, running on the top of eXo Core

Services to enable easy development of rich, user-centric web applications.

eXo Content is one such eXo Core service. It provides a set of services to extend portal-based

applications with Enterprise Content Management (ECM) capabilities. Document Management

System (DMS) features make it easy to catalog and organize enterprise content and with powerful

Web Content Management (WCM) services to quickly build dynamic, content-rich websites.

1.2. Why Use eXo Content

If you are looking for a powerful tool and strategies in managing website and contents, eXo Content

is what you need. eXo Content is designed to provide webmasters who manage websites the

way to maintain, control, modify and reassemble the content of a web-page easily and effectively.

All components of your website can be organized, or easily reconstructed, which helps you keep

your website under control. eXo Content really brings an interesting experience for all users and
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changes their way of thinking about website management. The followings are key features of eXo

Content:

Website Creation

Fast Setup:

Set up a new site in just a few clicks with an intuitive user interface and template features.

Navigate, Preview and Publish Content:

Navigate through page content in either a single content viewer or the list content display,

quickly preview page content or work on new content in draft mode and publish at anytime.

Templates:

Create websites from existing templates and themes, or create new templates with a

consistent look-and-feel across a single site.

In-Site Edition

The integrated rich text editor enables non-technical users to edit the pages they are in charge

of in an intuitive way.

Web Content Organization

Web-Based Administration:

Use a web browser to manage sites remotely, no local administration software is required.

Manage Multiple Websites:

Manage and control every site in one place.

Media Library:

Upload media to the library, publish, reuse and update all available media content across

multiple websites.

Content Search:

Search content and documents using categorization and tag features.

Broken Link Detection:

Know how many broken links are present and how many are functional with ease.

Versioning and Rollback:

Easily rollback a website's content with automatic versioning.

SEO and Friendly URLs:

Search Engine Optimization (SEO) is simplified for editing meta tags and more. Content has

its own specific URL for easier bookmarking and improved SEO.

Configuration for Deployment on Web Farms:

Advanced deployment rule for scalable, three-tier web application architecture with partitioned

replicated deployment.
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Capture and Manage Documents

Kofax Plugin:

Collect paper documents, forms, invoices and other unstructured documents and convert into

accurate and retrievable information, stored in the eXo JCR.

Access Control List:

Access Control List: Validate the current session's permissions to add nodes, set properties,

remove or retrieve items. Define actions to launch the next step in a process, or to invoke

any "coded" action required.

Workflow:

Specify processes for document collaboration and validation.

Record Management:

Track the status of content completion and control document storage life-cycles.

Store and Access Documents

JCR:

eXo JCR allows applications to access or manage files independent of their location, and also

provides advanced features such as unified access control, versioning, indexing and more.

Automatic Backup:

Define and automate tasks to save documents as required.

Web Interface:

Access documents in an intuitive and user-friendly web interface.

Microsoft and OpenOffice Plug-ins:

Microsoft and OpenOffice plug-ins give users the freedom to work on documents in their

preferred document editing program.

And More...  eXo Content also provides other powerful tools to manage and build content-rich

websites such as CSS, Java Script and RSS support, advanced document management tools,

collaboration tools and more. All eXo Content features are designed to meet your requirements

in site management and maximise the cost reduction that comes of managing multiple sites from

only one place.

1.3. About This Document

The intended reader of this user guide are users using eXo Content. This guide will explain all the

basic and advanced features that eXo Content provides in managing websites and site content.

It gives in-depth examples and easy explanations of the technology that allows the webmasters

to create and manage a very fast and powerful website.

With this guide you will:
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• Learn the basic terminologies used in eXo Content.

• Know how to create, manage and publish Site content.

• Know how to manage Web pages, set up a website, etc.

Default Accounts

The following accounts (username/ password) will be used throughout this guide:

• root/ gtn: This account is for users as Administrators who have the highest right

on the platform.

• mary/ gtn: This account is for a publisher who can write contents but also can

create new pages or edit them in the current site.

1.4. References and Related Sources

Information

• eXo Home Page [http://www.exoplatform.com/]

• eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/]

Support

• Forums [http://forums.exoplatform.org/]

• FAQs [http://faq.exoplatform.org/index.html]

Downloads

• eXo Content [http://www.exoplatform.com/company/public/website/platform/exo-core-services/

exo-content]

• eXo Development Tools [http://www.exoplatform.com/company/public/website/platform/exo-

core-services/exo-development-tools]

• GateIn Portal Framework [http://www.exoplatform.com/company/en/platform/exo-core-

services/gatein-portal-framework]

• eXo Collaboration [http://www.exoplatform.com/company/public/website/platform/exo-

extended-services/exo-collaboration]

• eXo Knowledge [http://www.exoplatform.com/company/public/website/platform/exo-extended-

services/exo-knowledge]

http://www.exoplatform.com/
http://www.exoplatform.com/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://forums.exoplatform.org/
http://forums.exoplatform.org/
http://faq.exoplatform.org/index.html
http://faq.exoplatform.org/index.html
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-content
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/public/website/platform/exo-core-services/exo-development-tools
http://www.exoplatform.com/company/en/platform/exo-core-services/gatein-portal-framework
http://www.exoplatform.com/company/en/platform/exo-core-services/gatein-portal-framework
http://www.exoplatform.com/company/en/platform/exo-core-services/gatein-portal-framework
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-collaboration
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-knowledge
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• eXo Social [http://www.exoplatform.com/company/public/website/platform/exo-extended-

services/exo-social]

Resource Center

• Video demos, tutorials, webinar archives, features and benefits tables and more [http://

www.exoplatform.com/company/public/website/resource-center]

http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/platform/exo-extended-services/exo-social
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
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Product Introduction

2.1. eXo Content

eXo Content is the singular name for the technologies used to capture, manage, store, preserve,

and deliver content and documents. It especially concerns content imported into or generated

from within an organization in the course of its operation, and includes the control of access to

this content from outside the organization's processes.

The eXo Content users can manage both structured and unstructured content, so that an

organization, such as a business or a governmental agency, can more effectively meet business

goals (increasing the profits or improving the organizational process with efficient use of budgets),

serve its customers (as a competitive advantage, or to improve responsiveness), and protect

itself (against non-compliance, law-suits, uncoordinated departments or turnover within the

organization).

eXo Content improves your operational productivity and efficiency. It enables you to transform

unstructured content into structured content through the process of capturing, storing, managing,

preserving, publishing and backing up while securely distributing it. The eXo Content portlet gives

you a portal solution that can help you achieve these processes and leverage your business

content across all formats for competitive gain. It also provides an environment for employees to

share and collaborate on digital content and delivering a comprehensive unified solution with rich

functionalities. Every component of your website can be organized, or easily reconstructed, which

helps you keep your website under control.

eXo Content consists of three parts:

Document Management System

An extension of eXo Content is used to store, manage and track electronic documents and

electronic images and allows documents to be modified and managed easily and conveniently

by managing versions, properties, and more.

Workflow

A way of looking at and controlling the processes presented in an organization such as service

provision or information processing, etc. It is an effective tool to use make certain that the

processes are effective with the purpose of better and more cost efficient organization.

Web Content Management

Which helps in maintaining, controlling, changing and reassembling the content on a web-

page. It also helps webmasters who handle all tasks needed to run a website, including

development, design, content publication and monitoring.
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2.2. Site Content Structure

While creating a site is a quick process, deciding what content to put into it and how to organize

that content can take some time. Therefore, to make managing a site as easy and effective as

possible, a site created with eXo Content will always adhere to a specific structure:

The Site Content is stored in collaborative workspaces of the underlying Java Content Repository

(JCR).

Details:

CSS

Files in this folder are used to define the presentation of your entire site, such as font, color,

size and more.

Documents:

All the documents which are used in the site will be stored in this folder.

JS

This folder contains programming scripts used on the site. Resources in this folder help make

a web page's graphics and navigation more animated and dynamic.

Links:

This folder stores all the links used in the site.

Media:

This folder contains three sub-folders:

Audios:

All sound files used in a site are stored here.

Images:

Pictures and other images used in a site are stored here.
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Videos:

All video files used in a site are stored here.

Web content:

This folder is used to store the documents which present the main site content (text, images,

hyperlinks, audios and videos) of the site.

2.3. Web Content

2.3.1. Web Content

The Web Content is the visual or aural content that is encountered as part of the user experience

on a website. It include any or all of the following elements; text, images, sounds, videos and

animations.

2.3.2. Web Content Structure

Much like the website as a whole, ensuring Web Content adheres to a specific structure makes

creating and managing the content more effective and dynamic.

Main content:

This is the key content, the text, images, links, tables, and other elements that make up the

bulk of the web content.

Illustration:

This folder contains an image that is used as an illustration for the content. A summary also

can be added to this image.

default.css:

This folder contains CSS data which is used to present the web content. CSS controls the

layout, font, color, and more.

default.js:

This folder contains JS data which is used to make web content more dynamic.

2.4. Terminologies

2.4.1. Repository

A repository is a location where data is stored and maintained. The content repository stores web

content and related digital data and is accessible to users locally, without requiring content to be

transferred across a network.

2.4.2. Workspace

A content repository is composed of a number of workspaces. Workspace is a term used by

several software vendors for applications that allow users to exchange and organize files over a

network (the Internet, for example).
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In this case, the content repository consists of more than one workspace. The repository repository

contains multiple workspaces, including: system, backup and collaboration workspaces.

System workspace:

This workspace is used to reserve system folders.

Backup workspace:

The backup process depends on the timestamps of published content; each published

document has a defined period for which it can be published and, when it exceeds that time

frame, it will be automatically archived to the backup database.

This workspace is mostly used when utilizing the Workflow based content publication life-

cycle.

Collaboration workspace:

This workspace allows users to validate and manage documents. This is the central place to

store and edit contents and media.

2.4.3. Drive

A drive can be understood as a shortcut within the content repository. It enables administrators

to limit the visibility of each workspace to groups of users. It also offers a visual simplification of

complex content storage arrangements by only showing the structure that is appropriate for users

to interact with.

More specifically, a drive consists of:

• A configured path where the user will start when browsing the drive.

• A set of allowed views that could, for example, limit the actions available to users (such as

editing or creation of content within the drive).

• A set of permissions to limit the access to, and view of, the drive to a defined number of users.

• A set of options to describe the behavior of the drive when users browse it.

2.4.4. Node

A node is an abstract basic unit used to build linked data structures, such as linked lists and trees

and computer-based representation of graphs. Nodes contain data and/or links to other nodes.

Links between nodes are often implemented by pointers or references.

A node can be defined as a logical placeholder for data. It is a memory block which contains some

data units, and optionally a reference to some other data (which may in turn be another node that

contains other data). By linking one node with other interlinked nodes, very large and complex

data structures can be formed.
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2.4.5. Version

Versioning means that, at any given time, the node's state can be saved for possible future

recovery. The action of saving is called 'checking in'.

A workspace may contain both versionable and non-versionable nodes. A node is versionable if

it has been assigned a mixin type mixin:versionable; otherwise, it is a non-versionable node.

A version exists as a part of a version history graph that describes the predecessor/successor

relations among versions of a particular versionable nodes.

Software versioning is the process of assigning either unique names or version numbers to unique

states of the software. Within a given version number category (major or minor, for example),

these numbers are generally assigned by increasing order and correspond to new developments

in the software.

At a fine-grained level, revision control is often used for keeping track of incrementally different

versions of electronic information, whether or not this information is actually computer software.

2.4.6. WebDAV

WebDAV stands for Web-based Distributed Authoring and Versioning. It is a set of extensions

to the Hypertext Transfer Protocol (HTTP) which allows users to collaboratively edit and manage

files on remote servers.

The protocol was developed to make the Web a readable and writable medium. It provides

functionality to create, change and move documents on a remote server (typically a web server

or "web share"). This is useful for authoring the documents which a web server serves, among

other things, but can also be used for general web-based file storage that can be accessed from

anywhere.
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2.4.7. Podcast

A podcast is an audio file that you can download and listen to on your computer or a portable

MP3 player such as an iPod™. The word itself comes from the combination of the words: iPod

and broadcast.

2.4.8. File Plan

The file plan is the primary records management planning document. Although file plans can differ

across organizations, their typical functions are to:

• Describe the kinds of items the organization acknowledges to be records.

• Describe what broader category of records that the items belong to.

• Indicate where records are stored.

• Describe retention periods for records.

• Delineate who is responsible for managing the various types of records.

2.4.9. Symlink

A symlink is a special file containing a reference to another document or folder. Symlinks can

make it easier to access the specific target node that the symlink points to. In Content Explorer,

a symlink can be identified by a small chain symbol next to its icon:
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Get Started

3.1. Account

3.1.1. Register an account

To register a new account on the portal, do as follows:

1. Go to the portal by entering the URL in the address bar (e.g: http://localhost:8080/portal/

public/classic).

The anonymous homepage will appear:

2. Click the Register link on the top of the site. The Register form will be displayed:

An asterix (*) indicates a required field.

http://localhost:8080/portal/public/classic
http://localhost:8080/portal/public/classic
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The Account Setting information includes:

Table 3.1.

Field Information

User Name The user name that is used to log into the

system. It must be unique. The user name

must begin with a character.

Password The security characters are used to login. It

must have at least 6 characters.

Confirm Password The re-typed password above. The

password in the Password field and this field

must be the same.

First Name Your first name.

Last Name Your last name.

Email Address Your email address. It must have a right

format: username@abc.com.

3. Enter the appropriate values for the fields in this form.

4.
Click the  icon to search and check if the chosen user name is available or not.

5. Enter values in the fields of User Profile tab, including: Profile information, Home

information and Business information.

6. Click Save to register a new account, or Reset to revert all completed fields.
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You will see an alert message and be unable to add a new account if any of the following

occurs:

• The User name already exists or is invalid.

• The Password has less than six (6) or more than thirty 30 characters.

• The Password and Confirm Password are not the same.

• The Email Address is in an invalid format.

• Any of the required fields are empty.

After adding a new account, contact the administrator to get a confirmation.

Email

Ensure you enter your email address correctly at this stage, as it is used in the

recovery process if you forget username or password.

3.1.2. Sign In

This function logs you into eXo Content in the private mode.

Procedure 3.1. Sign in

1. Go to your portal's home page by entering the URL in the address bar (e.g. http://

localhost:8080//portal/public/classic/).

2. Click the Login link at the top of the home page. The Sign in form will appear:

http://localhost:8080//portal/public/classic/
http://localhost:8080//portal/public/classic/
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Table 3.2. Options

Option Information

User name To input the registered username.

Password To input the password of your username.

Forgot your User Name/Password To retrieve the forgotten user name or

password when you forget.

Sign in To sign into the eXo Portal with the inputted

user name and password.

Discard To close the Sign In form without any

changes.

3. Enter your registered User name and Password.

4. Click Sign in to submit your details or Discard to exit the form.

If the User Name does not exist or the submitted User name/Password set is invalid, an alert

message will appear that requires users to re-submit the correct values. The page will be

redirected to the private security checking mode.

To login again, enter your User Name and Password again.

After signing in, you will be presented with the authenticated homepage:



Sign Out

17

Toolbar Visibility

The toolbar in the image above is, by default, only visible to members of the /

platform/web-contributors role.

See Section 3.1.6, “Toolbar Visibility” for information about how to add the required

permissions and/or change the default portal behavior.

3.1.3. Sign Out

The function ends your authenticated session and redirects you back to the anonymous portal.

To sign out, click the Logout link on the right access banner:

Alternatively, members of the /platform/web-contributors role can click Start Logo → Sign Out

from the toolbar:

3.1.4. Retrieve user name/password

If you forget your account or password, you can recover them by doing as follows:

Procedure 3.2.

1. Click the link Forgot your User Name/Password? in the Sign in form.

2. Select one of the two options:



Chapter 3. Get Started

18

Forgot my password:

If you forgot your password, you need to select this option.

Forgot my username:

If you forgot your username, you need to select this option.

3. If the Forgot my password option is selected the password recovery form appears:

If the Forgot my username option is selected, the username recovery form appears:

4. Enter either your username or email address, as appropriate, in the corresponding form.

5. Click Send to submit the recovery request.

Once the request has been sent, you will receive an email with the requested information,

(either your User name or Password at the email address that you registered.

• If you forget you username, an old username is restored and can be reused. A new

password will be sent to your email with the old username.

• If you forget your password: a new, temporary password will be set and sent to you. You

will be directed to change the password the next time you sign in.

3.1.5. Change account information

The function enables you change your account information, such as your profile and password.
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Procedure 3.3.

• To begin, click your username name in the top toolbar.

The Account Profiles form will appear:

Procedure 3.4. To Change Account Profiles

1. Select the Account Profiles tab.

This tab displays your current basic information.

2. Change your First Name, Last Name or Email. You cannot change your User Name.

3. Click Save to accept changes.

Procedure 3.5. To change your Password

1. Select the  Change Password tab.
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2. Enter your current password to identify that you are the owner of this account.

3. Enter your new password. The new password must be between six (6) and thirty (30)

characters long.

4. Enter the new password again in the Confirm New Password field.

5. Click Save to submit the changes.

3.1.6. Toolbar Visibility

Newly registered users (or other users who are not members of the /platform/web-contributors

role) will not see the toolbar at the top of the home page. These users will, however, be able to

sign into and out of the Portal using the appropriate buttons in the site header.

Portal administrators can add individual users to the /platform/web-contributors through the

graphical user interface (GUI):

Procedure 3.6. Add Permission via GUI

1. Click Group → Organization → Users and groups management, then click Group

Management.

2. Click Platform → Content Manager in the left pane.

3. Enter the required username in the Add member box (the above lists all users already in

that role).
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CMS Access

Be aware that granting this membership will also give the user access to the

Content Management System (CMS).

3.2. Change the display language

The priority order of display language is shown to the following order:

1. User's language

2. Browser's language

3. Portal's language.

Therefore, to display your preferred language, you should be attentive to this order to change the

language type appropriately.

1. Move the mouse over Start Logo → Change Language on the top left corner of the portal:

The Interface Language Setting form appears:



Chapter 3. Get Started

22

2. Select another language from the list. The currently selected language will be marked with

the  icon.

3. Click Apply to change the display language temporarily, and wait few seconds to take effect,

or click Cancel to quit without any changes.

3.3. Change the skin of the current site

Skins are attractive user interface styles for displaying a portal. Each skin has its own

characteristics with different backgrounds, icons and more. Changing the skin of the current site

can make use of the portal easier and more effective.

Procedure 3.7.

1. Hover the mouse pointer over the Start Logo then click on the Change Skin item in the

drop-down menu:

The Skin Setting form appears:

2. Select the skin you want by clicking its name.

3. Click Apply and wait a few seconds to take affect.
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This action can be performed by users who have the right to use the administration bar with a

personal preferences menu.
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Basic Actions
These actions are for all registered users after they have logged in the accounts.

4.1. View a site

In eXo Content, the term Website is used interchangeably with the term Portal. So, "Viewing a

portal..." means the same as "Viewing a website...". You can select the website that you want to

view by selecting its name in the drop-down menu on the administration bar:

The main screen of the site will appear. The illustration below highlights some important

components of the web page:

The Administration bar contains administration functions related to portals (websites).
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The Banner portlet contains things like the company name and logo used throughout the

website.

The Navigation bar helps users to visualize the structure of the website and provide quick

links to different pages.

The Home page is the main page of the website. This is the default page that is displayed

first when you visit the website.

The Footer is any texts, or image that is displayed at the bottom of the website. It provides

information about author/institutional sponsor, revision date, copyright and more.

4.2. Print content

Users can easily print any content in a site by following these steps:

Procedure 4.1. Printing content

1. Click Read more to read all the content of a document or an article in a site.

2. Click the Print button, the Print Preview page will be displayed on another tab.

3. Click Print to print the content of this page or Close to close this tab without printing.

4.3. Manage a site

4.3.1. Create a new site
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Note

Only administrators have the authorization rights required to create a new site in

eXo Content.

eXo Content administrators can create a site (portal) to meet their specific needs.

Do the following:

1. Click Site on the administration bar to see a list of existing portals.

2. Click the Add New Portal button to open the form to add a new portal.

In the Portal Setting tab, set some properties for this site including the portal name, locale

and skin.

Table 4.1. Details:

Field Information

Portal name The name of the portal. This field is required

and must be unique. Only alphabet, numbers

and underscore characters are allowed. The

Portal name must be at least 3 characters.
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Field Information

Locale The interface language of the portal. This

field is required.

Skin The skin of the portal.

3. Select the Properties tab to keep sessions alive.

The Keep session alive option defines the working session so as to avoid timeouts. There

are three options available:

never:

The session never happens even if the application requests.

on demand:

The session starts to be used as soon as the application requests.

always:

The session is always enabled.

4. Select the Permission Setting tab to set access and edit permission for this portal.

The Permission Setting tab includes two sub-tabs: Access Permission Setting and Edit

Permission Setting.
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Access Permission Setting tab

The access permission list of the portal is empty by default:

Check the Make it public check box to assign the access permission to everyone or click

the Add Permission button to assign access permissions to a specific group (select the

group you want to grant permission to from the Select Permissions form by selecting a

group on the left and a corresponding membership on the right).

Once the desired groups have been selected the access permission list is displayed:
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Groups can be removed from the Access Permission list by clicking the  icon.

Edit Permission Setting

The Edit Permission Setting tab is also empty by default. You must assign the edit

permission to a specific group.

You can assign the edit permission to a group with a specific membership by clicking the

Select Permission button to open the Permission Selector form. Select a group on the

left panel and a corresponding membership on the right panel:
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The asterix (*) in the Select a Membership panel is used to assign the right to everyone

in the group selected in the left panel.

After selecting a group, the Current Permission will be displayed with detailed

information:

The edit permission is assigned for only one group at one time. You can click the Delete

Permission button to remove the current edit permission of the selected group or re–

assign the edit permission to another group by clicking the Select Permission button

again and selecting another group.

5. Click Save to create the new portal.
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After creating a new site, the list of the existing sites will be displayed on the screen.

The new site will be added to the site list in Site on the administration bar and to a drive list that

includes all its default files.

To see it in the drive list, click Group → Content Explorer on the administrator bar.

For example, after creating a portal named eXo there is a drive named eXo in Content Explorer:

4.3.2. Edit a site

This function enables you to edit a site, including the settings, permissions and other configuration

options as well as the navigation and the layout components.

There are two ways to approach a site that you want to edit:

1. Edit the site that you are browsing through the Site Editor menu on the administration bar.

2. Edit another site by accessing it through the Sites menu on the administration bar.

4.3.2.1. By accessing to Site Editor

Directly edit the site you are browsing by navigating to Site Editor → Edit Layout.
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An editable layout of the site appears:

Table 4.2.

Field Details

Site's config Allows editing the site's configuration.

Switch View Mode Displays a view of the current layout with

content.

Finish Saves all changes and exits the Edit page.

Abort Cancels all changes that have not been saved

and quits the edit page.

Using this method you can only edit the layout and the configuration of site.

Edit layout.  Editing the layout allows more aspects of a site, including the banner, navigation

bar, breadcrumb bar, homepage or footer to be edited.

You can add more portlets to the site by dragging and dropping them from the Applications tab

of the Edit Inline Composer form to the main pane. Portlets can also be moved within the main

content pane by dragging them from one location to another.
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Editing Portlets

The editing process is similar for all portlets, therefore this guide will outline how

to edit the site banner portlet as an example.

Procedure 4.2. Edit Banner Portlet

1.

Open the form to edit a banner by clicking the  icon of the portlet in the Edit Portal

form:

A form to edit the current banner will appear.

2. Select the Edit Mode tab: Select the content path and set options for the portlet. See more

details about Edit Mode in Section 4.4.2.4, “Preferences”.

3. Select the Portlet Setting tab:
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Table 4.3.

Field Details

Display name The display name of the portlet (not

editable).

Portlet Title The title of the portlet (editable).

Width The display width of the portlet.

Height The display height of the portlet.

Show info bar. Tick the check box if you want to show the

info bar of the portlet.

Show Portlet mode Tick the check box if you want to show the

portlet mode.

Show window state Tick the check box if you want to show the

window state.

Description Enter a description about the portlet.

4. Switch to the Icon tab and designate an icon for the portlet by clicking it.

5. Switch to the Decoration Theme tab and chose a decoration theme for the portlet.

6. Select the Access Permission tab and set the access permissions for the portlet.

By default, all users can access the portlet:
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However, you can edit the access permission by clearing the checkbox and clicking Add

Permission:

The ListPermissionSelector form appears. Select a group on the left pane and a

membership on the right pane.

Note

The asterix (*) on the right pane denotes all members in the group.

7. Click Save and Close to commit.

8. Click the disk icon to quit the form to edit the current site.

Edit Configuration.  To edit the configuration (including language, skin and permissions) of the

site, click the  button to open the same form as the form to add a new portal.

Follow the same steps as in Section 4.3.1, “Create a new site”.
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Note

You cannot change the name of the site.

4.3.2.2. By accessing the Site

This approach way enables you to edit the layout, configuration and navigation bar of a site by

going to Sites and selecting the site from the existing site list.

Edit Layout.  Do the following to edit the layout of an existing site.

1. Click Site → Edit Layout to open a form to edit the site layout.

2. Follow the steps in the Edit layout process.

Edit Navigation.  Do the following to edit the navigation of a site.

1. Click Site → Edit Navigation to open the Navigation Management form.
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2. Click Add Node to open the ADD/EDIT PAGE NODE form.

3. In the Page Node Setting tab, enter a name for the node. This is a required value.

Table 4.4.

Field Details

Uri The node's identification. The Uri is

automatically created once a new node has

been created.
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Field Details

Label The node's display name on the screen. This

field may be changed and its length must be

between 3 and 60 characters.

Visible This checkbox allows the page and its node

to be shown or hidden on the navigation bar,

the page navigation bar and the sitemap.

See above for more details.

Publication date & time This option allows this node to be published

for a period of time. Two fields, including

Start Publication Date and End

Publication Date only display when this

option is checked.

Start Publication Date The start date and time to publish the node.

End Publication Date The end date and time to publish the node.

4. Select the Page Selector tab:

Table 4.5.

Field Details

Page Id The identification string of the page. It is

created automatically when the page is

created.

Name The selected page's name.

Title The selected page's title.

Clear Page To remove the input page information in the

fields
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Field Details

Create Page To create a new page with the input name

and the title.

Search and Select Page To search and select an existing page.

• Enter a title for the page.

• Click Create Page to create a new page or Search and Select Page to select an existing

page for the node.

5. Select the Icon tab to choose an icon for the node. This is optional.

6. Click Save to create a node for the navigation.

Editing via Navigation Management

You can edit/delete a node, edit a node's page, copy/cut a node and more by right-

clicking the node in the Navigation Management form.

Edit Configuration.  The portal's configuration including language, skin and permissions can

be edited by doing the following:

1. Click Site →  Edit Portal's Config to open the same form as the form to create a site.

2. Follow the steps in Section 4.3.1, “Create a new site”.

4.3.3. Switch between sites

This function is used to move from the current web site to another one.

Procedure 4.3.

• Hover your mouse cursor over Sites on the administration bar and choose a new site from

the site list that appears:
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The child pages of the new site will now be available in the site's entry under Site on the

administration bar:

4.3.4. Delete a site

This function is used to delete a portal (site) from the portal list.

Do the following:

Procedure 4.4.

1. Show the portal list by clicking Site on the administration bar:

2.

Click the  button in the row of the portal that you want to delete.

3. Click OK in the confirmation message to accept deleting.

Note

You cannot delete the Classic site by default.
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4.4. Contribute Content

4.4.1. Edit Mode

A site in eXo Content has two modes ( Published mode and Edit mode) which are specific for

viewing and editing the site, respectively. You can easily switch between these modes by selecting

in the drop-down list at the top left corner.

Edit mode

In this mode, you can edit all contents of the current site. When hovering the mouse pointer

over contents, you can see edit icons which enable you to quickly edit those contents. You

can take advantage of this feature to submit contents to a page.

Published mode

In this mode, you only can view the current site without editing the contents of the site.

When you login to a site, by default, the page is in the published mode, you cannot see any quick

edit icons and cannot edit site contents at this time:

When a page is switched to the Edit mode, you can see quick edit icons on the site contents when

mousing over them.

For Single Content Viewer (SCV), you can see the current state of the content, the Edit Content

icon and References icon.
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For Content List Viewer (CLV), you can see the current state of the content, theEdit Content,

References icon, the Add Content icon and the Management Content icon.

4.4.2. InContext Editing

InContext Editing enables you to edit content "in context" rather than having a WYSIWYG editor

pop-up over the top of the page. This feature makes page editing a much more user intuitive

process, with the new content automatically taking on the previous contents.

To use InContext Editing, turn on the Edit Mode.

4.4.2.1. Add Content

Adding a new content by InContext Editing is enabled for the Content List Viewer.

Do the following:
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Procedure 4.5. Add a new content

1. Turn on the Edit Mode and hover the mouse pointer over the CLV that you want to add a

new content in.

2. Click the Add Content icon on the CLV.

You will be redirected to the Content Explorer with a new document form for you to write

a document.

3.
Click the  icon to open the template list and select one.
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4. Fill all the fields in the form. See Section 4.7.4.2, “Add a document” to know how to add types

of document.

5. Click Save as Draft to save the document in a folder of the Collaboration drive.

Note

Saving a document in which folder of the Collaboration drive depends on the path

you choose inSection 4.4.2.4, “Preferences”.

4.4.2.2. Edit Content

You can edit any contents on the homepage for SCV and CLV with InContext Editing. For CLV,

you only can edit each content in it.

Do the following:

Procedure 4.6. Edit a content

1. Turn on the Edit Mode and over the mouse pointer over the content you want to edit.

2.
Click the  icon at the right corner of the content you want to edit. You will be redirected to

the Content Explorer with the document form for you to edit.

3. Edit the content and click Save as Draft to save the content.



Chapter 4. Basic Actions

46

4.

Click the  icon to return to the site and in the Edit Mode, the content in the draft state

will be visible.

Note

When you turn on the Published Mode, you cannot see the edited content. To

see it in the Published Mode, you must publish it. See Section 4.4.3, “Publication

Process” for instructions on how to publish content.
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4.4.2.3. Manage Content

With InContext Editing, you can easily manage a Content List Viewer on the homepage. You can

add a new content in the CLV, edit, delete an existing content or copy/cut/paste to another CLV

and take more actions in the right-click menu.

Do the following to manage content in the CLV.

Procedure 4.7. Manage Content

1. Turn on the Edit Mode and click the Manage Content icon of the Content List Viewer that

you want to manage on the homepage.

The browser will redirect to Content Explorer:

2. To add a new document to the CLV, click Add Document on the action bar and do the same

steps asSection 4.4.2.1, “Add Content”.
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To take other actions on a specific content in the CLV, right-click it to open a drop-down

menu. See more details how to takes the actions inSection 4.7.6, “Actions on Folders and

Documents”.

4.4.2.4. Preferences

Preferences enable you to edit contents in the Single Content Viewer (SCV) and the Content List

Viewer (CLV), reset the display of the contents in SCV and CLV and publish contents.

Content Detail Preferences.  Do the following to edit the Single Content Viewer:

Procedure 4.8. Edit Content Detail Viewer

1. Turn on the Edit mode and click the Preferences icon of a Single Content Viewer.

The Content Detail Preferences dialog appears:

Table 4.6. Content Detail Preferences

Field Details

Content Selection Select the path of the content that you want

to show by clicking the  icon.
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Field Details

Display Settings Allow configuring Title, Date and OptionBar

visibility.

• Show Title: Specify whether the title of the

content is displayed or not.

• Show Date: Specify whether the date of

the content publication is displayed or not.

• Show Option Bar: Show or hide the

Option bar used to show the print link.

Print Setting • Show in page: The content is shown in

the page.

• with: Parameters contains the content

path.

Advanced When clicking on this link, the Advanced

pane will be shown:

• Contextual Content: If the Contextual

Content property is set as "Disable",

the Advanced pane is closed by default.

The content should enable “dynamic

navigation” that interprets the URL and

shows a content.

• Cache Management: Allows you to use

a cache shared between users to get

contents. By default, Share content

between users is set as "Enable", the

contents displayed in CLV or SCV are got

from one cache.

Note

Click the  icon to see a quick help pane for each section.

2. Click the plus icon next to the Content Path to re-select another content. The Select Content

dialog appears:
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3. Choose a folder on the left panel and a content in the folder on the right panel. The content

chosen will be displayed in the Content Path field.

4. Tick the checkboxes, including the Show Title box, the Show Date and the Show Option

bar box if you want to display the content title, the publication date and the print button like

the illustration below:

5.
In the Print Setting area, click the  icon to open the UIPageselector dialog, you will

see Printviewer.

Click the Print button and the content is opened in the print viewer page.
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Example 4.1. Example

http://localhost:8080/ecmdemo/private/acme/  printviewer?

content-id  =/repository/collaboration/sites%20content/live/

acme/web%20contents/site%20artifacts/Introduce&isPrint=true

printviewer?: the print viewer page of the content.

content-id: the parameter containing the content path.

6. Click Save to save all the changes.

Content List Preferences.  To edit the Single Content Viewer, do the following:

Procedure 4.9. Edit Content List Viewer

1. Turn on the Edit Mode and click the Preferences icon of a Content List Viewer.

The Content List Preferences dialog appears:
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Table 4.7.

Field Details

Mode This mode is to select web content for list

viewer. There are two modes:

• By Folder: This mode allows you to select

a content folder in the Folder path field.

• By Contents: This mode allows you to

select by the content in a specific folder in

the Folder path field.

Folder path The path to a location of a folder that

contains the content.

Order by The field is selected to sort content in the list

viewer. You can sort content by Title, Date

created or Date modified in ascending or

descending order.

Header The title of all contents that are listed in List

Viewer.

Viewer template The template is used to view content list.

Paginator template The template is used to view each content in

the list.

Items per page The number of items will be displayed per

page.
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Field Details

Show image The option is to show or hide the illustration

of each published web content/document.

Show summary The option is to show or hide the summary

of each web content/document.

Show header The option is whether to show a header or

not.

Show refresh button The option is whether to show the refresh

button at the left bottom of this page or not.

Show title The option is to show or hide title of each

published web content and/or document.

Show date created The option is to show or hide the created

date of each published web content/

document.

Show link The option is to show or hide the link of web

content and/or document.

Read more The option is to show or hide the Read more

to read all the content of a web content and/

or document.

2. Browse the documents or web content of an available site by clicking the

icon next to the folder path field.

3. If you select the By folder mode, select an available site on the left, then select a folder that

contains contents (documents and/or web content) on the right by clicking the folder.

If you select the By contents mode, select an available folder from the left panel, all content

in this folder will be listed on the right panel. Click a content on the right that you want to add

to the content list. A message informs that you have successfully added it in the Content List.

The selected content is listed in the Content List.

4. Enter a header for the content list in the Header field if desired.

5. Select a template to display the content list in the template list.

6. Tick/untick the options that you want.

7. Click Save to save all the changes.

4.4.3. Publication Process

After a new content is created, it is saved as draft and you can easily to publish it on your site.

The publication process consists of four steps:
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Request approval → Approval → Stage → Publish

If you do not have the right to approve or publish content, you need to send an approval request

to have you content approved and published.

If you have the right to approve or publish a content, you do not need to send a request approval.

You can yourself publish it with the Stage step immediately.

Request approval

When a new content is created, it must be approved before publishing by clicking Request

Approval on the action bar of the Content Explorer or clicking Pending in the Manage

Publication form:

Approve

To approve a content, clickApproveon the action bar of the Content Explorer or click

Approved in the Manage Publication.

Stage

Stage enables you to publish a content in a period. After selecting the publication schedule

for the content, it will be automatically published as the schedule.

To publish content for a stage, click Stage and click From/To to open a mini calendar and

select the date to publish.

To publish your content indefinitely, you should not set time in the To field.
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Publish

A content will be published when you have completed the Stage step.

Note

You will see a list of draft contents, pending contents which are waiting to be

your approval if you have the approval right and contents that will be published

at the bottom of the Content Explorer. Click your desired contents to review,

approve or publish.

4.5. Content Inside Categories

You can create new contents in any folders or directly in a CLV with Incontext Editing. However,

creating contents inside a category helps you easily and quickly manage and publish them.

4.5.1. Categories in eXo Content

Categories are used to sort and organize documents to ease searches when browsing documents

online. After creating a document, you should categorize it by adding it to a category.
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Alternatively, creating documents directly in categories automatically creates links to them within

the category. When you browse the category, the referenced documents will be found and

displayed as children of the category node.

Categories are stored in the JCR itself .

4.5.2. Create a Content

This section will show you how to create a content in a category.

Procedure 4.10. Create a content

1. Go to Group → Content Explorer and select a drive. For example; Acme  is available as

a drive in the following illustration:

2. Highlight a category in the left pane and click the Add Document button to create a new

document under the selected category (see Section 4.7.4.2, “Add a document” for instructions

about how to add a new content). The new content is a symlink.

Click the symlink to view the content.
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4.6. Dynamic Navigation

Dynamic Navigation enables you to set a parameter to configure the portlet by URL. This means

that the URL containing the content path can be dynamically changed.

This section shows you how to use Dynamic Navigation in eXo Content.

Procedure 4.11. Access Dynamic Navigation

1. Turn on the Edit Mode and hover the mouse cursor over either an SCV content element or

a CLV content element, and then click the Preferences icon to open the preference form for

SCV or CLV respectively.

2. Show the Dynamic Navigation pane by clicking the Advanced link at the bottom of the

preferences window.

Example 4.2. Dynamic Navigation in SCV

Table 4.8.

Field Details

Contextual Content • Disable: Means a single content will be

opened by an URL containing the Content

Path.

• Enable: This portlet is configured with

the provided parameter (content-id by

default).
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Field Details

By This parameter is the key in the URL to let

SCV know which is the path in the current

URL. It is editable when Contextual Content

is enabled.

For example, open a single content with the Content Path ACME Introduce. The URL of the

content is the following:

http://example.com:8080/ecmdemo/private/acme/printviewer?content-id=/repository/

collaboration/sites content/live/acme/web contents/site artifacts/Introduce&isPrint=true

Example 4.3. Dynamic Navigation in CLV

Table 4.9.

Field Details

Contextual Folder • Disable: A single content will be opened

by an URL containing the Folder Path (for

CLV).

• Enable: The path of content list (Folder

Path in the Content Selection path) can

be dynamically changed by URL.

By This parameter is the key in the URL to let

CLV know which is the actual path in the

current URL.
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Field Details

Show in page A single content in CLV will be shown in a

selected page. You can choose any page but

you should take one with a Content Detail

Portlet. The Content Detail Portlet should

enable “dynamic navigation” that interprets

the URL and shows a single content.

With This parameter is the key in the URL to let

SCV know which really is the path in the

current URL.

4.7. Content Explorer

4.7.1. Access Content Explorer

Content Explorer is used to manage all site documents in different drives. Content Explorer offers

network access to the content, regardless of where the user is located. By default, any user can

access Content Explorer but only users holding particular roles can perform actions in Content

Explorer.

Procedure 4.12.

• Go to Group → Content Explorer on the administration bar:

A list of all drives (organized into the groups; Personal drives, Group drives and General

drives) is displayed:



Chapter 4. Basic Actions

60

Personal drives:

A Personal drive is the working space of a user. Within this space there is a Private

drive which is locked to anyone but the user and a Public drive for shared resources and

collaboration.

Group drives:

A Group drive is a working space for all members of that group.

In the following example, the user root joins in three groups : executive-board,

administrators and users so he has the right to access these groups' drives.
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General drives:

A General drive is the working space for all users, however your access rights in different

drives depends on your role. If you access in an administrator role you can see all drives,

otherwise, as a web-contributor, you can only see some drives.

4.7.2. Drives

4.7.2.1. Private drive

Private drives contain personal data of registered users. Hence, only these individuals can

access data in this drive type.

There are some default folders set up to store a user's private resources.

•

By selecting the Actions tab, you can:

• Create a new folder.

• Create a new document.

• Upload file from your devicef.

• Add Symlinks.

• Overload Thumbnails.

• By selecting the Collaboration tab, you can:
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• Watch/Unwatch a document.

• Add tags for a document.

• Set multi-display languages for document.

• Vote for a document.

• Comment for a document.

• By selecting the Search tab, you can:

• Perform a simple search.

• Perform an advanced search with more constraints, add new query to search.

• Search by existing queries.

• In addition, you can:

• Set up your browsing preferences.

• Cut/paste, Copy/paste, Delete a node.

• Lock a node.

• Rename a node.

• Use the view WebDAV function to view document content.

• Download documents (folders) to your machine.

4.7.2.2. Public drive

There are no default folders in a Public drive, but users can create any folders they require.

All actions available to users in Private drives are also available in Public drives.
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4.7.2.3. Drive of a specific group

Group drives have two default folders, but others can be added as needed. Users can utilize the

same actions as in Private drives, the only difference being that only users in the drive's owner

group can access the drive.

4.7.2.4. Shared Users Space drive

By default, there will be a list of all existing users, each user has a folder with their username.

Each user's folder includes two sub-folders (private and public). You can see both your private

and public folders here but you only can see the public folder of other users.

• In this drive, you can:

• Perform all actions that you can do in your private drive.

• View nodes from public folder of others.

• In this drive, you cannot:

• Add a folder/document in a root node.

• Add a folder/document in another users' folder or to child nodes of this folder.

• Add folders/documents to the top-level folder (the one bearing your username), only in its

child nodes public and private.
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• Rename a default folder.

• Lock folders belonging to another user.

• Delete a default folder.

4.7.2.5. Show/hide the sidebar in a drive

The sidebar is used to show nodes like a tree or show the related documents, tags, clipboard

and saved searches.

You can show/hide the sidebar in two ways:

1. Procedure 4.13. Method 1

1.

Click the  icon to open the Preferences:

2. Untick the Show sidebar checkbox then click Save.

The drive will be displayed like the illustration below:

3. To show the sidebar, tick the Show sidebar checkbox in Preferences.

2. Procedure 4.14. Method 2

1. Click the Expand icon to hide the sidebar:
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2. Click the Collapse icon to reveal the sidebar again.

4.7.3. Views

There are many drives in the Content Explorer. Each drive has different views that allow you to

look at the data in the drive in a particular way. Each view has various actions available on tabs

in the viewing pane.

eXo Content offers four ways to view nodes in a specific folder and show the corresponding actions

on the Actions bar.

View Types

The number of View types depends on which drive you are browsing. You can

manage the view types in eXo Content Administration. See Section 5.2.2.3,

“Manage Views” for details.

4.7.3.1. Admin view

In this view, each item in the list includes the following information: Name, Date Created, Date

Modified, Owner and Versionable and Auditing. This information will help you manage nodes

more easily.
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You can sort nodes based on node information by clicking the label of the corresponding column.

The  icon indicates that nodes are ordered in ascending order and the  icon means nodes

are in descending order.

4.7.3.2. Icons View

In this view, nodes in a specific folder will be viewed as icons. The name of each node will be

shown under its icon.

4.7.3.3. Thumbnails View

With Thumbnails view, nodes in a specific folder are viewed as icons bounded by frames. Name

of each node is shown under its icon.
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If nodes are image files, their thumbnails will be shown as so:

Additionally, when in this view, you can overload a thumbnail image for a node. For example, if

you want to add a thumbnail image for the Digital Assets folder, do the following:

Procedure 4.15.

1. Select a folder (on the left or right panel) that you want to add a thumbnail image.

2. Click the

icon to open the Add thumbnail image form.

3. Select an image from your machine to use as a display icon for the selected folder.

4. Complete adding a thumbnail image by clicking Save. This node will be stored in a

exo:thumbnails folder.

5. Back to the parent folder (folder Pictures in this example) that contains the selected folder

to see a icon used to display.

4.7.3.4. Cover Flow View

This view is defined as a dynamic view with side-scrolling views of nodes in a folder. In this view,

when a node is selected, its name is set with bold effect to set it apart from others.
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If nodes are pictures, they appear as:

If nodes are documents or folders, they are displayed as:

You can move from one node to another in one of three methods:
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• Use the mouse wheel.

• Hold and move the yellow circle button to the left or the right.

• Click the folder/document name that you want to select.

4.7.3.5. Slide Show View

In this view type, pictures in folders are viewed in a slide show.

To view pictures in the slide show, click the  icon:

If nodes are pictures, they are displayed as:

The Slide Show view automatically show all picture nodes. Users can control this slide show by

clicking the below buttons:

Table 4.10.

Button Function

Go to the first picture node.
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Button Function

View the previous picture node.

Pause the slide show.

View the next picture node.

View the last picture node.

Continue viewing pictures node.

4.7.3.6. Timeline View

This view enables users to view all nodes created and uploaded by time. To use it, click the 

icon.

All the nodes that were created and uploaded will be displayed in a timeline:

You can click directly on the node name to view its content in details.

You can also click the  icon to mark your item as favorite or the  icon of a favorited node

again to remove it from favorites.

4.7.4. Actions

Actions appear as tabs on the action bar of the Content Explorer pane. They are managed by

administrators. The actions visible to any given user will depend on their role permissions and the

tab and drive they are browsing.

This section discusses the actions available in eXo Content's Content Explorer and how to use

them.
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4.7.4.1. Add a category

This function enables you to add a category to a node.

Do the following to add a category:

Procedure 4.16.

1. Choose a node to which you want to add a category.

2.
Select the  button on the action bar and the Add Category form appears:

3. Enter a name for the category in the Category Name field.

4. ClickSaveto create a new category or Cancel to quit from this form without adding a category.

4.7.4.2. Add a document

There are several types of document in eXo Content, includingFile, Article,Podcast,Sample node,

File Plan andKofax.

The table below shows nodes types to which different document types can be added. The rows

indicate what the node in the left column can be added to. The columns indicate what the node

at the top can contain.

Table 4.11.

File Article Podcast Sample

node

File

Plan

Kofax

document

Content

folder

Document

folder

File

Article    

Podcast

Sample

node

    

File Plan   

Kofax  



Chapter 4. Basic Actions

72

File Article Podcast Sample

node

File

Plan

Kofax

document

Content

folder

Document

folder

Uploaded

file

Content

folder

  

Document

folder

  

Note

•
The  icon indicates that the corresponding document can be added into.

• A blank entry means the corresponding document cannot be added into.

Follow the horizontal, you will know what the node can be added to.

Follow the vertical, you will know what the node can include.

Do the following to add a new document:

Procedure 4.17. Add a new document

1. Select a folder from the left panel where you want to add a new document.

2.

Click the  button on the Actions bar.

3. Select the document type (template) that you want to create from the drop-down list ( Article

is selected by default).

Each document (exceptArticle) must be added to categories when being created.

Procedure 4.18. Attach files to a document

1.
Select a document that you want to attach files to and click the  button on the

Actions bar.
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The Upload file form will appear.

2. Enter a name into the Name field, otherwise, the Name field is automatically added with the

name of the file.

3.

Click Browse to select the attachment file. You can click the  icon to add multiple files.

4. Click Save to attach the files or Cancel to quit.

Procedure 4.19. Create a new File document

1. Follow the steps in Add a new document to open the Add New Document form, then select

File from the Select Template drop-down list.

The Add New Document form will be displayed.

2. Enter a name for the file document in the Name field. Some special characters cannot be

used in the Name field: @ # % & * ( ) “ ' : ; [ ] {} / !

3.
Click the  icon to see the Mime Type list and select one. There are two types of File

document for you to choose:

• text/html: When creating a text/html File document, you can input source code (HTML, for

example) in the Content field. After being created, the desired content will be generated,

then you can see both the inputted source code and the generated content in that

document.

• text/plain: After being created, the content will display exactly what you entered in the

Content field.
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4. Input a value in the Content field:

• text/html: If chose to create a File document with source code and then generated content

(inStep 3), click the  button in the editor bar. In this mode, only theSave,

New Page and Preview icons are available. Click the  icon to preview the generated

content.

• text/plain: If you selected text/plain type in Step 3, the content field will be displayed like so:

5. Fill values in all the fields, includingTitle,Description, Creator andSource.

Click the plus icon to open more fields.

6. Click Save as Draft to create a new File document.

After being created successfully, a text/html File document will be displayed as:
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You can see both the original and rendered views in the respective tabs at the top of the

window:

Procedure 4.20. Create a new Article

1. Follow the steps in Add a new document to open the Add New Document form. The Article

type should be selected by default. If not, select it from the Select Template drop-down list.

The Add New Document form will be displayed.

2. Input the name and the title of the Article in the Name and Title field, some special characters

cannot be used in the Name field (@ # % & * ( ) “ ' : ; [ ] {} / !).

3. Enter some content in the Summary and Content fields.

4. Click Save as Draft to save the entered content or Cancel to quit without saving.

After being created, the new added Article document will appear as so:
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The Links section is used to list all its related documents. After adding relations for a document

you can click these links to view the content of the related documents.

The Attachments section is used to list all its uploaded files/documents that is attached with the

Article. You can remove the attachments by clicking the  icon.

For more details about how to add an attachment, seeAttach files to a document.

Existing Names

Document names can be the same as an existing document. When a new

document is created with the same name as another document, the new document

name will have an added index (e.g:test [2]).



Actions

77

Procedure 4.21. Create a new Podcast

1. Follow the steps in Add a new document to open the Add New Document form and select

Podcast from the Select Template drop-down list.

The Add New Podcast form will be displayed.

Table 4.12.

Field Details

Name The name of a document. This field is

required. Some special characters (@ # % &

* ( ) “ ' : ; [ ] {} / !) are not allowed.

Title The title of a document.

Categories The categories of a document.

Link The link to the source path of the uploaded

media file. This field is required.

Author The author of the uploaded media file.

Explicit This field is used to indicate whether or not

your Podcast episodes contain an explicit

content.

Category The category of the uploaded media file,

example: music, film, short clip, etc.

Keyword Keyword allows you to search your Podcast

files more quickly. You can use commas to

separate between keywords.

Publish date The date when an episode was released.

Description Information about the uploaded media file.

Mime type The type of the uploaded media file.

Length The length of the uploaded media file.

2. Enter values for the above fields. To upload a media file, click the Browse... button and select

the media file from your machine.

3. Click Save as Draft to finish.

Existing Names

Document names can be the same as an existing document. When a new

document is created with the same name as another document, the new name will

have an index added (e.g:test [2])
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Once created, a Podcast will appear as so:

Podcasts can be listened to immediately, or transferred to another device.

Procedure 4.22. Create a new Sample node

1. Follow the instructions in Add a new document to open the Add New Document window and

select Sample node from the Select Template drop-down list.

The Add New Sample Node form will appear.

2. Complete the appropriate fields.

3. To upload an image, click the Browse... button and select an image from your computer.

4. Click Save as Draft to accept.

After being created, a new sample node will be displayed like the illustration below:
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The Relations area is used to list all related documents. SeeSection 4.7.4.15.3, “View Relations”.

You can click the links to view content of the related document.

The Attachments area is used to list all its uploaded files. SeeAttach files to a document.

Procedure 4.23. Create a new File Plan

1. Follow the instructions in Add a new document to open the Add New Document window and

select File plan from the Select Template drop-down list.

The Add File plan form will appear.

2. Fill in the appropriate fields of the tabs in the Add File plan form.

3. Click Save as Draft to accept creating a file plan.
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Tabs in the Add File plan form

The Name tab

Table 4.13.

Field Details

Name The name of the file plan.

Categories The categories of your file plan. Select the

categories for your file plan by clicking the

 icon.

File Plan note A Note can be added to offer further

information to users.
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The Record properties tab

Table 4.14.

Field Details

Record category identifier The alphanumeric identifier indicating a

unique record category. This must be a

unique ID and if left blank will be created

automatically by the system.

Disposition authority A reference number to the regulations that

govern the disposition.

Permanent record indicator A type of record indicators which should

never be deleted.

Disposition instructions A readable guidelines on how the records

associated with the file plan will be

handled.

Contains records folder The confirmation is about whether the

records folder is contained or not.

Default media type The choice for preset media types which

are made available to simplify the data

entry for the record. This is usually set to

electronic orpaper.
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Field Details

Default marking list Handling and classification information

that are printed at the bottom of

the record, such as UNCLASSIFIED

orNOCONTRACT.

Default originating organization This option will set a defaultoriginating

organization. This can simplify the data

entry that needs for record keeping. It

assumes that the originating organization

is the same for all the information in the file

plan.

Vital record indicator This flag is to allow whether tracking or

reminding you of the record as essential or

not.

Vital record review period The choice for the interval of time between

vital record reviews.

The Process Properties tab:

Table 4.15.

Field Details

Process cutoffs The boolean data type is used to break a

process. If the process cutoff flag is set in

the file plan, the record is cutoff after the
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Field Details

expiration, or after it has been obsolete or

superseded, depending on the information

in the file plan.

Event trigger The text data type is an automatic

executing code which is used to tell the

event to perform some actions.

Cutoff period The duration for the record cutoff

performance.

Cutoff on obsolete The record is cutoff when it is obsolete.

Cutoff on superseded The record is cutoff when it is removed or

replaced.

Process hold This boolean data type is used when a

record process may be held before the

further disposition is handled.

Hold period The duration when a record may be held

after cutoff which is normally measured in

years.

Discretionary Hold The boolean data type is used when a

hold may be discretionary, such as after

a command change. So, the discretionary

hold flag allows the records management

module to track these manual checks.

Process transfer The boolean data type is used to

determine how a record process will be

transferred.

Default transfer location The text data type is used to determine

where a record is transferred by default.

Transfer block size The float data type is used to determine

in what size blocks for organizational

purposes that is normally measured in

Years.

Process accession The boolean data type is flagged when

a record which is held permanently must

be ultimately transferred to the national

records authority.

Accession location The text data type is flagged to specify an

area for the accession transfer.
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Field Details

Accession block size The text data type is flagged to determine

the blocks size for organizational purposes

which is normally measured in years.

Process destruction The boolean data type is flagged if there

is any record to be destroyed. After that,

the record is marked in the Alfresco system

to be permanently destroyed so that all

information, metadata and physical traces

are removed and cannot be recovered.

After being created, the new File Plan will be displayed:

Procedure 4.24. Create a new Kofax

1. Follow the instructions in Add a new document to open the Add New Document form and

select Add New Kofax from the Select Template drop-down list.

The Add New Kofax form will appear:
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2. Enter a name for a Kofax document in the Name field. This field is required. Some special

characters cannot be used in the Name field(@ # % & * ( ) “ ' : ; [ ] { } / !).

3.

Select categories for the document by clicking the  icon.

4. Click Save as Draft to create the document.

A newly created kofax document will be displayed like this:

The File View tab is used to display all added nodes in that Kofax. All added files in that Kofax

are also displayed in the Document View tab:

Procedure 4.25. Create new Event

1. Follow the instructions in Add a new document to open the Add New Document form and

select Event from the Select Template drop-down list.
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The Add New Event window will appear:

2. Enter a title for the event.

3. Enter the location where the event will take place in the Location field. Check the Google

Maps checkbox if you want the location of the event shown on Google Maps.

4. Enter the Start and End Date/time of the event.

5. Fill the Summary and Content fields.

6. Click Save to commit the event.

After being created, the event will be displayed like the illustration bellow:

The event will be displayed in a website as:
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4.7.4.3. Add a folder

You can create a document directly in a specific drive; however, adding documents to a specific

folders allows more effective document management.

There are two types of folder:

• Content folder.

• Document folder.

In the default Portal skin, the icon for a content folder node is displayed in blue and the icon for

a document folder node is displayed in yellow.
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File and folder types in a folder

Content folder

• You can add a Content Folder into a Content Folder.

• You can add a Document Folder into a Content Folder.

• You can add documents into a Content Folder.

• You can upload files into a Content Folder.

• You can import subnodes exported into a Content Folder.

Document folder

• You can add a new Document Folder into a Document Folder.

• You can add File, Podcast, File Plan documents into a Document Folder.

• You can upload files into a Document Folder.

• You cannot add a Content Folder into a Document Folder

• You cannot import an exported a Content Folder into a Document Folder.

• You cannot import an exported Article, Sample node, Kofax into a Document Folder.

Procedure 4.26. Create a folder

1. Select the path to create a folder.

2.
Click the  button on the action bar. The Add a Folder form is displayed:

3.
Click the  icon to see the type list and select a folder type.

4. Enter a name in the Name field. This field is required. You cannot use some special characters

in this field (@ # % & * ( ) " ' : ; [ ] {} / !)
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5. Click Save to create a new folder.

Duplicate Names

A folder can have the same name as an existing folder. When a new folder is

created with the same name with another, the new name will have an index number

added (e.g:test[2]).

You can only create a content folder in another content folder.

You can create a document folder in a content folder or a document folder.

4.7.4.4. Add translations to a document

This function enables users to add multiple languages for a document. This action is similar to

adding a language.

By default, the Add translation button is not displayed on the action bar.

Enable this function by navigating to Administration → Content Presentation → Manage Views

. See Section 5.2.2.3, “Manage Views” to know how to add the Add translation button to the tabs

on the action bar in Content Explorer.

Procedure 4.27.

1. Select a document you want to add the translation for. For example, select an Article which

is inEnglish:

2.
Click the  button on the action bar. The Symlink Manager will appear:
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3.

Click the  icon, then browse to the target document that has different language with the

first document. For example, the Article version in French.

4. After you have selected the document, click Save on the Symlink Manager form:

5. Select the document which you have added the translation to, then click the Relation button

on the sidebar.

You will see the available language for the selected document. Click the language on this

panel to view the document in the corresponding language version.
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4.7.4.5. Add Symlink

You also easily add a Symlink for a document for the purpose of fast accessing the document

that you are looking for:

Do the following to add a Symlink:

Procedure 4.28.

1. Select a document that you want to point a Symlink to.

2.

Click the  button on the action bar. The Sym Link Manager pop-up will

appear:

Table 4.16.

Field Details

Path Node The path of a link

Symlink name The name of the link.

3.

Click the  icon to open the Choose Target Node form.

4. Choose the workspace which contains the node that you want to add a Symlink:
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5.
Click the  icon in the row of the node that you want to add, the path of the node will appear

in the Path Node field and the name of the node is set by the name of the selected node.

You can also edit this name.

6. Click Save to add Symlink.

4.7.4.6. Comment

This function is used to comment on a document (Note: you cannot comment for a File Plan

document).

Procedure 4.29.

1. Select a document that you want to add a comment to.

2.

Click the  button on the action bar.

The Add Comment form appears:



Actions

93

3. Add your comment in the Comment field.

4. ClickSave.

Comments are shown at the bottom of the document:
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To view your comment click the Show Comments link:

You can edit your comment by clicking the  icon or delete it by clicking the  icon.

4.7.4.7. Edit a document

There are two ways to edit a document.

Procedure 4.30. Method One

1. Select a document you want to edit in the left panel.
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2.

Click the  button on the action bar.

Or:

Procedure 4.31. Method Two

1. Select a folder that contains the document you want to edit.

2. Right-click the document you want to edit and select Edit from the menu.

The Edit Document form will appear. All information of the selected document will be

displayed in this form and ready for you to change except the Name field.

3. Click Save to commit the changes.

4.7.4.8. Export nodes

Nodes can be exported into either .xml or .zip file types.

Procedure 4.32.

1. Select a node that you want to export.

2.

Click the  button on the action bar to show the Export Node form:

Table 4.17.

Fields Details

Path to Export The path of the node being exported. This

field will be pre-populated.
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Fields Details

Format The format of the original node.

Document View Each node is a tag and properties of that

node are considered to be elements of that

tag.

System View Each node and each property of that node is

included in a different tag.

Zip If this field is checked, the node will be

exported as a .zip file.

3. Click Export and choose a location to save the exported file.

Exporting Versioned nodes

The Export Node form will offer an Export version history button if the node

being exported, or any of its child nodes, is versioned.

This action exports all of the node's version history.

4.7.4.9. Import Nodes

Nodes that are in the .xml file format can be imported in to the JCR Explorer system.

Procedure 4.33.

1. Select the location that you want to import the new node to.

2.

Click the  button on the action bar . The Import Node form appears.
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3. Click Browse next to the Upload File field and navigate to the file you want to import.

4. Select the UUID from the drop down menu:

Create new

A new UUID will be created for the new node.

Remove existing

The new node will be created in the selected path with the UUID it was exported with.

Replace existing

The imported node will replace the existing node and UUID.

Throw Exception

This option will display an alert informing you if you cannot import the file.

5. Click Browse next to the Version history to select a version to import.

6. Select a format.

7. Click Import to import the chosen version of the selected file.

4.7.4.10. Manage Actions

4.7.4.10.1. Add an action

Procedure 4.34.

1. Select the node you want to add an action to.

2.

Click the  button on the action bar.

The Manage Actions form will appear.

3. Select the Add Actions tab to open the form to add an action to the folder.
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4.
Click the  icon and select the type of action from the drop-down menu.

Table 4.18.

Field Details

exo:action This action is not supported.

exo:AddMetadataAction This action adds metadata

exo:autoVersioning This action automatically adds a version.

exo:createRSSFeedAction This action creates an RSS file.

exo:enableVersioning This action enables versioning.
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Field Details

exo:getMailAction This action fetches mail

exo:sendMailAction This action sends mail.

exo:taxonomy/Action This action creates categories

exo:transformBinaryTo TextAction This action converts .pdf or .doc file types to

plain text.

5. Complete the required fields in the form for the selected action.

Table 4.19.

Field Details

ID The Id of action. This field is created

automatically and cannot be modified.

Name The name of this action. This name is internal

to the JCR explorer.

Lifecycle Select the lifecycle for this action. The action

will be executed depending on the lifecycle:

• Add: The action will be executed to a new

document, but not to a subfolder when the

document or the subfolder is created in the

folder in which an action has been added

to. It's also applied to a new document in

the subfolder of the folder.

• Modify: the action will be executed when

a folder /node is modified.

• User action: The action is executed

when right-clicking on the folder and then

selecting the action.

• Remove: The action will be executed to

a document, but not to a sub-folder in

the folder when the document or the sub-

folder is moved.

• Schedule: the action is done at specific

time. There are 2 schedule lifeless

types: period and cron. (See more about

Schedule lifecycle).
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Field Details

If you need the same action to be executed

in several lifecycles, you have to create

several actions.

6. Click Save to commit the action.

All actions of a node are listed in the Available Actions tab.

Once an action is added to a node it is automatically added to any child nodes of the selected node.

If an action added with the lifecycleuser action, it will be applied for the current node. And an

action added with other lifestyles, it will be applied for the child nodes.

Actions in menus

Not all actions are listed in a nodes right-click menu. Some will be performed

immediately when that action is added.

4.7.4.10.2. View Actions

Procedure 4.35.

1. Open the Manage Actions form and select the Available Actions tab.

2.
Click the  icon that corresponds to the action you want to view.

The details will be displayed in the Action info tab:
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4.7.4.10.3. Edit an action

Procedure 4.36.

1. Open the Manage Actions form and select the Available Actions tab.

2.
Click the  icon that corresponds to the action you want to modify.



Chapter 4. Basic Actions

102

3. Edit the properties in theActions form:

4. Click Save to commit the changes.

4.7.4.10.4. Delete an action

Procedure 4.37.

1. Open the Manage Actions form and select the Available Actions tab.

2.
Click the  icon that corresponds to the action you want to modify.
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3. Click OK on the confirmation dialog box to delete the action.

4.7.4.11. Manage Auditing

This function logs property changes in nodes.

Procedure 4.38.

1. Select a node.

2.

Click the  button on the action bar. The Activate Auditing message

appears.

3. Click Activate to activate auditing on the selected node.

4.

Click the  button again to view audit information for the selected node.

The Auditing Information list appears.

If the node has no audit information the form will appear like this:
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4.7.4.12. Manage Categories

4.7.4.12.1. Add a category for a node

You can add categories to document type nodes only:

Procedure 4.39. Add a category

1. Select the node that you want to add a category to.

2.

Click the  button on the action bar.

The Add category form appears.

3. Select the Select category tab to show the available categories.

4.
Click the  icon to add the corresponding category to the node.

Categories that have been added to a node are listed in the Referenced categories tab of the

Add categories form.

All nodes belonging to a category can be viewed by doing the following:

Procedure 4.40. View a category

1. Go to the drive that contains the category you have added. There will be a list of categories

available.
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2. Select a category you want. The documents in that category will be listed.

Copy/paste nodes

When copying and pasting a node in a drive, a new node with the same content

will be created with a different name.

When copying and pasting a node in the category tree, a reference to the original

node will be created. This reference is a link rather than a copy. This feature

preserves disk space.

4.7.4.12.2. Delete a Category

Procedure 4.41. Delete a category

1. Select a categorized node.

2.

Click the  button.

3. Select the Referenced categories tab.

4.
Click the  icon that corresponds to the category you want to delete.

4.7.4.13. Show/Hide a content

Nodes can be hidden or revealed as desired.

Procedure 4.42. Hide a Node

1. Select the node you want to hide.
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2.

Click the  button on the action bar to hide the node.

A message box will appear with a confirmation that the node has been hidden.

3. Show a Node

To reveal a hidden node, click the

button again.

4.7.4.14. Manage Publications

This function is used to manage node publication.

Procedure 4.43. Manage Publications

1. Select a node (on the left or right panel) which you want to manage the publication.

2.

Click the  button on the actions bar.

The Manage Publications form appears:

The Revision tab displays some basic information and the current state of the selected node.
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3.

Click the  icon to view the content of the node or click the  icon to restore a version

(refer to Section 4.7.4.16, “Manage Versions” for information about versioning).

4. Select the History tab to view the publication history of the node.

5. Click Save to commit any changes made.

Important

See Section 4.4.3, “Publication Process” to understand more Manage

Publication

4.7.4.15. Manage Relations

You can use this function to create relationships between nodes

4.7.4.15.1. Add a relation

Procedure 4.44. Add a relation

1. Select the node you want to add a relations to.

2.

Click the  button on the action bar.

The Add relation form appears.

3. Select the Select relation tab to see a list of other documents.

4.
Click the  that corresponds to the document(s) that relate to the document selected inStep

1.

Documents linked to the original via a relation will be listed in the Relation List tab.

Relation Rules

• Relations can only be added to document and uploaded file node types.

• A node cannot have a relation to itself.

4.7.4.15.2. Delete a relation

Procedure 4.45. Delete a relation

1. Select a node that has links to related documents.
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2.

Click the  button on the action bar.

3. Select the Relation List to view the relations for the selected node.

4.
Click the  corresponding to the relation you want to remove.

5. Click OK on the confirmation message to delete the relation.

The related document will be removed from the list.

4.7.4.15.3. View Relations

Procedure 4.46. View Relations

1. Select a node that has links to related documents.

2. Click the relation button on the side panel:

All nodes related to the selected node will be displayed in the left pane:



Actions

109

3. Click the name of the related node to view the document.

4.7.4.16. Manage Versions

4.7.4.16.1. Add versions for nodes

Procedure 4.47. Add version

1. Select a node to add a version to.

2.

Click the  button on the action bar.

The following message box will appear:

3. Click Activate to activate a version for the node.

4. Right-click the selected node and select CheckIn from the right menu:

5.

Click the  button again to open the Version Info window.
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The node selected in Step 1 has been added as theBase version.

6. Right-click the node again and select Check out to obtain a version of this node.

Note

No actions (copy/cut/rename) can be taken on a node in Check In status. You must

check it out before you can perform any actions on it.

If you want to add more versions for a node, right-click the selected node above

and select Check In and thenCheck Out.

4.7.4.16.2. Add and Remove labels for Versions

Procedure 4.48. Add a label

1. Select a versioned node.

2.

Click the  button on the action bar.

3.

Click the  icon on the Version Info window to show the Add label field under the version

list.
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4. Enter a value into the Label field.

The label must be unique and cannot use special characters such as @, #, $.

5. Click Save to submit the new label.

Procedure 4.49. Remove a label

1. Select a versioned node that has at least one label.

2.

Click the  button on the action bar.

3.

Click the  icon on the Version Info window to show the Remove label field under the

version list.

4. Select the label you want to remove from the drop down menu:

5. Click the Remove button to remove the selected label.

4.7.4.16.3. View versions

Procedure 4.50.

1. Select a versioned node.
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2.

Click the  button.

3.
Click the  icon to see the current versions of the selected node.

Folder Nodes

Version viewing is not supported on folder nodes.

If you click the  icon while the selected node is a folder, a message to this

effect will appear.

4.7.4.16.4. Restore versions

Procedure 4.51.

1. Select a node that has at least two versions stored.

2.

Click the  button.
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3. Select the version that you wish to restore as the base version.

4.

Click the  icon to restore the selected version

4.7.4.16.5. Delete versions

Procedure 4.52.

1. Select a node with at least two versions:

2.

Click the  button.

3.
Click the  icon corresponding to the version you want to delete.

A confirmation message will appear.

4. Click OK to delete the version or Cancel to quit.

Base Versions

You cannot delete a base version.
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4.7.4.17. Multi Languages

This function is used to support users to add multiple languages for a document. Each document

can be displayed in many languages.

Procedure 4.53.

1. Select a document that you want to add language(s).

2.

Click the  button on the Action bar.

The Multi-language form will appear.

The View language tab contains a list of all languages. The default language for the

document will be automatically populated.

3. Select the Add language tab. This tab will be displayed differently, depending on what file

you selected. However, the area where you can add languages for document is the same.

The below illustration shows the Add language tab for a Sample node file:
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4. Select a language you want to add from the Language drop-down list.

If the selected language has not been added for current document, the content field will be

blank.

Select the Set default checkbox if you want to set your selected language as default

language.

5. ClickSave, you will be returned to the View language tab. Your selected language is now

added to the Language field:

You can view this document in the new added language by selecting the language from the

language drop-down list then click the View button.

To view the languages list of a document, do the following:
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Procedure 4.54. View the language list

1. Select a document that you want to view the language list, then click the Relation button

on side panel:

2. The list of language (and all related documents) will be displayed on the left panel:

You can view the document in the new language by clicking the corresponding link in the

Languages List.

For more details about Relations, refer toSection 4.7.4.15.3, “View Relations”.

File Plan Language

You cannot add multiple languages to a File Plan or any subnodes of a File Plan.

4.7.4.18. Overload Thumbnails

You can overload a thumbnail image for a folder. Overloading allows a folder to be represented

by a thumbnail image, rather than a folder icon.
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To overload a thumbnail, do the following

Procedure 4.55. Overload thumbnails

1. Select the folder you wish to overload with a thumbnail image.

2.

Click the  button on the action bar.

The Add thumbnail image form appears:

3. Click Browse... button to select the image to use as the display icon for the selected folder.

4. Click Save to commit the change. The node will be stored in an exo:thumbnails folder.

4.7.4.19. Request Approval

When a content is created, if you want to publish it but you do not have the right to publish the

content, you must send an approval request for your content.

Do the following:

Procedure 4.56. Request Approval

1. Select a content that you want to send an approval request to publish.

2. Click the Request Approval button on the action bar.

The content is displayed at the bottom of the Content Explorer of the people who have the

right to approve contents.
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4.7.4.20. Approve a content

When a content is created by users, it maybe need approved to publish if there is a approval

request. To approve a content, do the following:

Procedure 4.57. Approve a content

1. Select a content that needs approving.

2. Click the Approve Content button on the action bar and the content is ready to be published.

Note

The Approve Content button is only invisible for users who have the right to

approve contents.

By default, the button is not displayed on the action bar.

Enable this function by navigating to Administration → Content

Presentation → Manage Views . See Section 5.2.2.3, “Manage Views” to

know how to add the Approve Content button to the tabs on the action bar

in Content Explorer.

4.7.4.21. Publish a content

After the content is approved, it can be published by the people who have the permission to publish

contents.

Do the following:

Procedure 4.58. Publish a content

1. Select a content that you want to publish.

2. Click the Publish Content button on the action bar. The content will be published as the

schedule that you set up.

Note

The Publish Content button is only visible to users who have the right to

publish contents.

By default, the button is not displayed on the action bar.

Enable this function by navigating to Administration → Content

Presentation → Manage Views . See Section 5.2.2.3, “Manage Views” to
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know how to add the Publish Content button to the tabs on the action bar

in Content Explorer.

4.7.4.22. Show Drives

This function enables you to show or hide all the drives in Content Explorer.

To show drives, click the  button on the action bar.

To hide drives, click the  button again.

4.7.4.23. Show JCR Structure

This function allows you to view nodes in documents in a tree structure.

Show the JCR structure

1. Select a document.

2. Select the Info tab.

3.

Click the  button.

4.

Click the  icon to save the view.

The following information message will appear:
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Hide the JCR structure: select a document is showing the JCR structure, then click the

 button again.

4.7.4.24. Tag Documents

A tag is a (relevant) keyword or term associated with or assigned to a piece of information (a

picture, a geographic map, a blog entry, a video clip etc.). Tags describe the item and enable

keyword-based classification and searching.

Procedure 4.59. Add a new tag for a document

1. Select a document that you want to add tags to.

2.

Click the  button on the action bar. The Tag Manager will

be displayed:

Table 4.20.

Fields Details

Tag names The tag names that users want to add tags

for documents.

Tag Scopes To classify tags. There are four tag types:

private, public, group, site. Currently, the two

first types are activated(Private: a user who

create tags can view and edit tags; public: all

users can view and edit tags).

Linked tags To list all tags of a document after you click

the Add Tags button.

3. Enter a value in the Tag names field. A document can be added several tags at a time by

entering multiple tags in the Tag names field and separate by a comma (,).
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4. Select a value for the Tag Scopes field.

5. Click Add Tags to accept, or Close to quit. Only you can see this tag in this document.

6.
Click the  icon to delete tags.

Procedure 4.60. Remove tags from a document

1. Select a document with tags that you want to remove.

2.

Click the  button on the action bar to open the Tag Manager

form.

3.
Click the  corresponding to the tags you want to delete.

4. Click OK on the confirmation message to delete the tags.

4.7.4.25. Upload files into folders

This function allows you to upload a file from your machine. All file types can be uploaded. The

uploaded file name cannot include the special characters: ! @ $ % & [ ].

Procedure 4.61. Uploading a File into a Folder

1. Select the folder that you want to upload a file into (you can select from either the left or right

panels).

2. Select the Actions tab to show some actions on the action bar.

3.
Click the  button on the action bar to open the Upload a file form:
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4. Browse and select a file on your device by clicking the Browse... button. The selected file

name will be displayed in the Select a file field.

If you want to upload multi files at the same time, click the  icon to open more forms

to upload more files:

The  icon closes the upload file form.

5.
You can change the uploaded file by clicking the  icon and clicking the Browse... button

again to select another file.

6. By default, the name of the uploaded file will be kept as original but if you want to change,

you can type a new name in the Name field (the new name must not contain the special

characters: ! @ $ % & [ ]). This field is not required.

7.

You can click the  icon next to the List Taxonomy field to add categories for this file:
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8.
Select categories by clicking the  icon. Click the plus to open child nodes of categories.

Note

You can add more categories for a file by clicking the  icon again to open

the Add Categories form.

Click the  icon to delete a category in Upload a file form.

You can also manage categories which were added to files by using the

Manage Categories function. SeeSection 4.7.4.12, “Manage Categories”.

9. Complete uploading file by clicking Save.

10. After being saved, the main information of the uploaded file will be displayed:
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11.
Click the  icon to see more details of its external metadata information. The List external

metadata tab will be enabled. Values can be entered into fields on this tab.

12. Click Save to accept changes or Cancel to quit without any changes.

13. Data can be added to the uploaded file. Check the checkbox, then click Add or Cancel to

quit without adding anything.

14. New metadata is displayed in the External Metadatas list and this can be edited it by clicking

the  icon.

15. Click Close to quit the Uploaded information form.

16. After being uploaded, the tree is displayed in the left panel:
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File Size Limits

The size of the uploaded file depends on the size limit of the uploaded file that

you set up in the Edit mode of Content Explorer. If your file size exceeds the

limit, a pop-up message will appears to alert you.

4.7.4.26. View Metadata

This function allows you to view the metadata attached to File nodes, Podcast nodes, File Plan

child nodes and uploaded file nodes ( nt:file nodes)

Procedure 4.62.

1. Select an appropriate (nt:file) node.

2.

Click the  button. The View Metadata form appears:
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3. Click the Add/Edit button at the bottom of the View Metadata form to add metadata.

4.

Complete the desired fields in the Add/Edit Properties form. Click the  icon to add

further metadata.
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5. Click Save to commit the new metadata values.

4.7.4.27. View Node Types

To view detailed information about a node:

Procedure 4.63.

1. Select a node that you want to view the detailed information for.

2.

Click the  button to view detailed information about the selected node.
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3. Click the tabs at the top of the form to view categorized information.

4.7.4.28. View Permissions

This function enables an administrator to manage the permissions for nodes.

Procedure 4.64. View Permissions

1. Select a node.

2.

Click the  button. The Permissions Management form appears.
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With the Permissions Management form open you can perform the following actions:

Procedure 4.65. Add Permissions

1. To add permission for specific users

Click the  icon next to the User Or Group field.

Click the  beside the users you want to grant permissions to.

2. To select users from a specific group

Enter a group name in the Group field at the top of the form (for example, /platform/users).

All users in the nominated group will be displayed.

Or;

Click the  icon beside the Group field to open a form that lists groups and their sub-

groups. Select a sub-group to add all users in that sub-group.
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3. To search for a user

Select an information parameter (User Name,First Name, Last Name,Email) from the drop

down menu in the other field at the top of the page and enter the information into the text box.

Click the  to search for users that match that information.

4. To add permissions based on memberships

Click the  button next to the User Or Group field.

The Select membership form that appears allows you to select users by membership. Select

a group on the left pane and then select membership types on the right.

5. To add all users/groups with read access

Click the  icon next to the User Or Group field.

6. Select the permission you want to grant the chosen users or groups by ticking the

corresponding checkboxes beside the rights you want to add.

7. Click Save to commit the changes. The new permissions will appear in the permissions table

above.

Procedure 4.66. Edit Permissions

1. Select the permission of a user or a group in the table of list permissions.

2.
Click the  icon.

3. Change the permissions as desired.



Actions

131

4. Click Save to commit the changed permissions.

Procedure 4.67. Delete Permissions

1. Select the permission of a user or a group in the table of list permissions.

2.
Click the  icon.

3. Click OK in the confirmation message to remove the permission.

4.7.4.29. View Properties

This function allows users to review all the properties and values of a node. It can also be used

to add values to a node.

1. Select the node that you want to review or add values to.

2.

Click the  button to show the Properties Management form:

This form has two tabs:

Properties

This tab displays all properties and values for the selected node.
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Select this tab to review the properties for the selected node without making any changes.

Add New Property

This tab contains fields to add new properties to the selected node.

Select this node if you want to make changes to the properties of the selected node.

3. To add new properties:

Select the namespace for the property.

4. Enter a name for the new property in the Name field.

5. Select a Type for the property from the drop-down menu for the field Type.

6. Enter a value for the property in theValue.

7.

To add multiple new values, click the  icon and repeat the above steps.

To remove a value, click the  .

8. Click Save to commit the new values or Reset to clear any modified fields.

After you commit new properties, you will be returned to the Properties tab. The newly added

values will be displayed.
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In this form you can edit a property by clicking the  icon or delete it by clicking the  .

4.7.4.30. View Relations

This function shows documents related to a selected node.

1. To View Relations

Select a node then click the  button. Documents related to the selected

node will be shown in the sidebar.

If the node does not have any related documents the message No related document will

appear instead.
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2. To Hide Relations

Click the  button again to hide relations.

4.7.4.31. Vote

This function is used to vote for a document (Note: you cannot vote for a File Plan document).

Procedure 4.68.

1. Open the document you want to vote for.

2.

Click the  button on the action bar.

The Vote Document form will appear:

3. Rate the document by clicking on the appropriate star level for your vote:

After a vote has been added, the rating will appear at the bottom of the document:

4.7.4.32. Watch Documents

By using this function, whenever a change is made on the document, an email notification will be

sent to your email address. To receive that email, you must configure in your mail server.

Procedure 4.69.

1. Select the document you want to watch.
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2. The Watching Document form will appear. Click the Watch button to finish.

To stop watching a document, select the document and click the  icon.

A message will appear for you to confirm the action.

4.7.5. Manage Content In Content Explorer

A web content is a key resource in creating a site. Other resources make a site more dynamic

and animated by using layout, color, font, and more. This section focuses on how to manage a

web content in a specific site.

Note

Only users who have the right to access the Sites Management drive can manage

web content.

4.7.5.1. Create a new web content

This function is used to add a new web content into a specific site.

Procedure 4.70. Add new content

1. Go to the Sites Management drive and select a site that you want to add a web content to.

2. Select the web content folder on the left:
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Note

You also can add the new web content into other folders (documents and

media folder) of a site but it is recommended that you add new content to the

web content folder because:

• It will allow you to manage web content of a site more easily.

• If you add a new web content in this folder, you don't need to select a web

content document in the list of document types. This makes adding a new

web content more flexible.

3.

Open the Add New Document form by clicking the  icon on the Action bar.

4. Select a template in the Select Template field to present web content:

The Select Template field has two options:

• Picture on head layout web content: The site's content is presented in two spaces. One

for inserting an image and one for editing the site's content. In which, the image is put at

the head of a site.

• Free layout web content: This template is a free layout.

5. Enter values in the fields of the Add New Document form.
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6. Click Save as Draft to save the content or Cancel to exit the form.

7. Tabs in the Add New Document form

The Main Content Tab includes:

Table 4.21.

Field Options

Name The name of a web content that you want to

add new

Title The title of a web content

Main content The main content that you want to display

when publishing this web content

Save button To save the inputted values

Cancel button To exit the current form

The Illustration Tab allows you to upload an illustration that makes the site's content more

attractive.
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Table 4.22.

Field Option

Illustration Image The path to an image that you want to upload

into a site. This image will be used like an

illustration of that site.

Image Type The image format that you want to upload

to the site. It can be: image/gif; image/png;

image/jpg; image/jpeg.

Summary You can supply a short description about the

web content that will be displayed with the

illustration image when the web content is

listed. The main content will be shown when

it is selected to be viewed.

Do the following to upload an image:

Procedure 4.71.  Upload an image

1. Browse an image list on your local device by clicking the Browse... button and then

select a specific location.

2. Select an image in the list to upload.

The Advanced tab:

This tab includes two parts: CSS data and JS data:
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Table 4.23.

Field Information

CSS data Contains CSS definition to present data in a

web content. You can optionally enter CSS

data into this field to specify the style.

JS data Contains JS content to make the web

content more dynamic when after publishing.

You can optionally enter JS content in this

field.

4.7.5.2. Edit a web content

This function is used to edit a web content in a specific drive of an existing site.

Do the following:

Procedure 4.72. Edit a web content

1. Go into the folder of a site which contains the web content that you want to edit.

2. Select the web content by double-clicking it on the left tree or on the right panel. The detailed

information of web content will be viewed on the right panel.
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3.

Click the  icon on the action bar to show the edit form of the selected

web content as the Add New Document form.

4. Change the current values in the fields of this edit form.

5. Complete editing the selected web content by clicking Save.

Auto-lock

When you click Edit Document, the web-content will be auto-locked for editing.

After finishing, the content reverts to unlocked status. You can manage Locks in

the Administration portlet.

4.7.5.3. Delete a web content

This function is used to remove a web content from the web content folder in a specific site's drive.

To delete a web-content, do the following:

Procedure 4.73. Delete a web content

1. Right-click the name of the web content that you want to delete and then select Delete in

the drop-down menu:

2. A confirmation message will appear. Click OK to accept the deletion, or Cancel to quit without

deleting.

4.7.5.4. Publish a web content

This function helps you publish a web content that you have added to web content folder in Content

Explorer.
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See Section 4.4.3, “Publication Process” to know how to publish a web content.

After the content is published, all users who have the right to access that position can view the

published web content as a page on the Navigation bar.

4.7.6. Actions on Folders and Documents

This section will discuss actions that can be performed on folders and document, both from the

right-click menu (Cut and Paste for example) and manual actions (like dragging and dropping).

The actions available in the right-click menu are different for folders and documents.

The actions available for documents are:

The actions available for folders are:
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4.7.6.1. Add to favorites

This function helps users easily add nodes (documents, folders or files) as favorite.

Procedure 4.74.

1. Right-click a node you want to add as a favorite

2.
Click the  entry in the drop-down menu.

A symlink of your favorite nodes will be created in the Favorite folder.

4.7.6.2. Copy/Paste

This function is used to make a copy of a node (including subnodes) in other places.

There are two ways to cut/copy/paste the node:

Procedure 4.75. Method One

1. Right-click the node then select Copy from the drop-down menu.

2. Select a destination node that you want to be the parent node of the cut/copied node.

3. Right-click the destination node and select Paste from the drop-down menu.

Pasting Content

The Paste function is only enabled after some form of data (a document, for

example) has been added to the Clipboard through the Copy or Cut action.

4. The copied folder (and any sub-folders) will be pasted to the new selected path.

Procedure 4.76. Method Two

1. Right-click the node and select the Copy from the drop-down menu.

2. Select the destination node that you want to be the parent node of the copied node.

3. Select the Clipboard icon on the sidebar:
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4. Click the clipboard window will appear:

5.
Click the  icon in the clipboard window to paste the copied node into the selected

destination node in Step 3.

6.
You can click the  icon to delete a specific waiting statement.

7. You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information

about the destination path.

Copy/Paste Considerations

• You only can use the Copy action if you have the appropriate permissions on

the source node.

• You only can use the Paste action if you have a right on the destination node.

• If the destination node contains a file with the same name as the copied file, the

pasted file will have an index integer added to its name.

For example; New Folder contains a node named Live which is copied and

pasted into a location that already contains a node named Live. After the
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paste action the new file will be named Live[2]. The original Live file will be

unchanged.

• You cannot copy a content folder into a document folder.

• Pasting a node does not remove it from the Clipboard. Therefore, after using the

Copy action you can use Paste to copy the node into multiple nodes without

needing to use the Copy action again.

4.7.6.3. Edit documents

To edit a document, refer to Section 4.7.5.2, “Edit a web content”.

4.7.6.4. Cut/Paste

This function is used to move a node (include subnodes) to other places. There are two ways to

cut/paste documents:

Procedure 4.77. Method One

1. Right-click a node and select Cut from the drop-down menu.

2. Select the destination node that you want to be the parent node of the cut node.

3. Right-click the destination node and select Paste in the drop-down menu.

Pasting Content

The Paste function is only enabled after some form of data (a document, for

example) has been added to the Clipboard through the Copy or Cut action.

4. The cut node (and its subnodes) will be pasted to the new selected path.

Procedure 4.78. Method Two

1. Right-click a node and select Cut from the drop-down menu.

2. Select the destination node that you want to be the parent node of the cut node.

3. Select the Clipboard icon:
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4. Click the Clipboard window will appear:

5.
Click the  icon in the clipboard window to paste the copied node into the selected

destination node in Step 3.

6.
You can click the  icon to delete a specific waiting statement.

7. You can also click the Clear All link to delete all waiting statements in the list.

After the action has been taken, a confirmation message will appear with detailed information

about the destination path.

Cut/Paste Considerations

• You only can use the Cut action if you have the appropriate permissions on the

source node.

• You only can use the Paste action if you have a right on the destination node.

• If the destination node contains a file with the same name as the copied file, the

pasted file will have an index integer added to its name.
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For example; New Folder contains a node named Live which is cut and pasted

into a location that already contains a node named Live. After the paste action

the new file will be named Live[2]. The original Live file will be unchanged.

• You cannot Cut a content folder into a document folder.

• Pasting a node does not remove it from the Clipboard. Therefore, after using

the Cut action you can use Paste to copy the node into multiple nodes without

needing to use the Cut action again.

4.7.6.5. Delete folders and documents

This function helps you remove folders/documents from theirs location easily. Follow the steps in

Section 4.7.5.3, “Delete a web content”

Delete Rights

• You can only use the Delete action if you have the appropriate permissions on

the node.

• If the deleted node contains subnodes, these will also be deleted.

4.7.6.6. Drag and drop folders and documents

This function allows you to move folders or documents from their current location to another by

using the drag and drop feature.

Procedure 4.79.

1. Move the cursor to the folder(s) or document(s) in the right panel until the cursor changes to

. You can hold the Shift key to select multiple contiguous folders/documents at once or

the Ctrl key to select multiple non-contiguous files.
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2. Hold the left mouse button and then drag the selected folder(s)/document(s) to another folder

on either the right or left panes.

3. Drop them into the selected folder by releasing the left mouse button. All dragged folders/

documents will be relocated to the destination folder.

4.7.6.7. Lock/Unlock folders and Documents

This function prevents other users from changing specific folders/documents for a specific period.

Lock folders/documents.  Right-click a folder or document (on either the right or left window

pane) and select Lock from the menu. The selected node will be locked.
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Locking Rights

• Only users with appropriate rights can lock folders or documents.

• After a node is locked, other users can view the locked node, but cannot alter or

remove it. They can, however, create and edit a copy of the locked node (using

the Copy/Paste functions outlined above).

• A lock will be kept on a node for the current session only. The lock will be

automatically removed when the user who locked the node signs out.

• A lock will also be automatically removed if no action is taken on the locked node

for thirty (30) minutes.

Unlock folders/documents.  To unlock a node you have locked, right-click it and select Unlock

from the menu. The folder/document will then be unlocked and other users can take actions on it.

4.7.6.8. Rename folders and Documents

This function is used to change the name of a folder/documents.

Procedure 4.80.

1. Right-click a folder/document that you want to rename then select Rename from the menu:

The rename form will appear:
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2. Enter a new name in the Name field. You can also change the title of this folder by entering

a new one in the Title field.

3. Click Save to commit the new details.

4.7.6.9. Add a symlink

Creating a symbolic link (symlink) to a node is an effective way to quickly access that node from

other nodes without having to navigate through the content structure manually.

Procedure 4.81.

1. Right-click a document that you want to add a symlink to (in this instance the term to is used

to describe the node as the target of the symlink, not an addition to the original node itself)

and select Add SymLink from the menu.

2. A symlink to the selected document will be created immediately. You can click the symlink

to view its content.

4.7.6.10. View WebDAV

WebDAV allows users to access (read and write) files and folders over the web. WebDAV is used

to view nodes because it offers easy, quick, flexible and efficient data manipulation.

Procedure 4.82.

1. Select the path of node you want to view via webDAV or open that folder from the left/right

panel.

2. Right-click the node and select the Download and Allow Edition item in the menu.

3. The view in WebDAV form will be different for different node types:

Table 4.24.

Node Type WebDAV Details

Folder The subnodes list of the current folder will be

displayed in WebDAV.
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Node Type WebDAV Details

nt:file The content of the document will be shown.

Article This node type does not, by default, list

any folders. However, if the Article includes

actions, added language or other data, all

folders will be listed and named; exo:actions,

exo:language and so on.

Podcast Viewed in WebDAV, this node type will have

a form attached that users have to complete

to download this document.

Sample node This node lists folder names as exo:images.

Like Article nodes, if the Sample node

contains actions or added languages, folders

will be named exo:actions, exo:language

and so on.

File Plan This node behaves the same way as Article

and Sample node.

Kofax This node behaves the same way as Article

and Sample node.

4.7.6.11. View Document

This function opens a document on another tab with a link containing the document path.

Do the following to view a document.

Procedure 4.83. View a document

• Right-click the document that you want to view and select View Document in the drop menu.

The document is opened in another browser:
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The URL of the document is structured like so:

http://example.com:8080/ecmdemo/private/acme/siteExplorer/repository/path/to/document

4.7.6.12. Copy URL to Clipboard

The Copy URL to Clipboard enables you to copy the WebDAV URL of a selected folder or a

document and then you can view it by WebDAV view on a browser.

Do the following:

Procedure 4.84. Copy URL to Clipboard

1. Right-click a folder/document and select Copy URL to Clipboard.
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2. Paste the URL into another browser window (or another tab in the same browser window).

You can view the folders of the node or download documents to your device. You also view

other nodes by clicking the folder named .. to go up to the parent node. See the below

illustration:

4.7.6.13. Manage Tags

Tags are easily managed by editing or deleting them with the Tag Manager.

Procedure 4.85. Edit a tag

1.

Click the  icon at the upper-right corner of the tags panel.
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The Edit tag form will appear:

2.
Click the  icon that corresponds to the tag you want to edit.

3. Edit the tag as desired.

4. Click Save button to commit the change or Cancel to quit without changes.

Procedure 4.86. Delete a tag

1. Perform Step 1 from the procedure above.

2.
Click the  icon.

A confirmation box will appear:
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Click OK button to delete the tag or Cancel to quit.

Procedure 4.87. Use Created tags

1.

Click the  icon. You will see all existing tags. All existing tags are listed and classified

by private or public tags.

Tags will be displayed differently depending on popularity. The font-size, font-weight, color,

font-family, text-decoration will change to visually represent popularity.

For example, when a tag is added to more than ten documents it will be displayed in red with

in a 20px size, bold font. These details can be configured in the Administration portlet.

2. Each tag is also like a link used list all documents that it is added. Click a tag name to see a

list of documents with that tag displayed in the right panel.

4.8. Manage Content with WebDAV

4.8.1. What is WebDAV?

WebDAV is an abbreviation of Web-based Distributed Authoring and Versioning. It is used to

publish and manage files and directories on a remote server. It also enables users to perform

these functions on a website.

WebDAV provides the following features:

Locking

This feature prevents two or more collaborators from overwriting shared files.
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Site Manipulation

WebDAV supports the copy and move actions and the creation of collections (file system

directories).

Name space management

This function enables copying and moving web pages within a server's namespace.

4.8.2. Why use WebDAV?

With WebDAV, you can manage content efficiently. You can:

• Copy/paste content on your device and have those changes reflected in a host-based website.

• Easily and quickly manipulate actions on a website without having to access it directly. Files

can be accessed from anywhere and are treated as if they were in local directories.

• Easily and quickly upload content to a website simply by copying it into the appropriate directory.

4.8.3. How to Use WebDAV With eXo Content

To use WebDAV with eXo Content, you first need to have an active network connection. Next,

you can follow one of the two following ways:

Procedure 4.88. Method One: WebDAV server

This procedure uses Windows XP as an example. Please modify the following steps to suit your

operating environment:

1. Navigate to My Network Places on your local computer. You will see all shared files and

folders:
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2. Click the Add a network place link on the left to open the Add Network Place Wizard:

3. Click Next to choose a network location:
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4. Select Choose another network location to create a shortcut.

5. Enter an address into the Internet or network address field. For example, the address

of the demonstration site Acme is http://localhost:8080/portal/rest/private/jcr/repository/

collaboration/sites/content/live/acme.

6. Click Next. After a few moments, a folder named acme on localhost appears in the My

Network Places directory.

Each site managed by WebDAV appears as a folder in this location.

7. You can take actions on the content in this folder to administrate the site content remotely.

Procedure 4.89. Method Two: Sites Management

This method can be done using the Sites Management functionality of eXo Content:

1. Navigate to http://localhost:8080/portal in your web browser.

2. Click Group → Content Explorer in the administration bar.

3. Click the Drives button then select Sites Management.

http://localhost:8080/portal/rest/private/jcr/repository/collaboration/sites/content/live/acme
http://localhost:8080/portal/rest/private/jcr/repository/collaboration/sites/content/live/acme
http://localhost:8080/portal
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You will see all sites listed in the left sidebar:

4. Right-click the site you want to view with WebDAV and select the Download and Allow

Edition item in the menu.
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The selected site will be shown in WebDAV:

In this view, you can access documents in the directories that are linked to the web server.

4.8.4. Actions

You see all the default folders of a site when accessing it via WebDAV. Manipulating their content

through WebDAV is the same as working on it in local folders.

This allows you to copy or paste files, list folders, rename, and more in system directories.

4.8.4.1. Add new content to a specific site

This function enables you to copy web content (such as .html files) from your local computer to

a web content folder of a site.

1. Access a site via WebDAV (refer to Section 4.8.3, “How to Use WebDAV With eXo Content”),

then go to a web content folder within the site.
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2. Copy the web content on your local system into this folder.

The copied file will be converted to web content that is viewable by WebDAV automatically.

The content is converted to a directory containing CSS, documents, js and media.

After new content is added, it can be viewed as a folder in WebDAV or as page content using

a web browser.

4.8.4.2. Delete a web content

This function enables site administrators to delete web content files separately or in batches.

Procedure 4.90.

1. Navigate to the folder that contains the content you want to remove.

2. Right-click the content files or directories (hold the Ctrl key to select multiple files at once)

and select Delete from the context menu.

The selected file(s) will be removed from the site.

4.9. Search in Content Explorer

There are three ways to search an existing node:

1. Section 4.9.1, “Quick Search”.

2. Section 4.9.2, “Advanced Search”.

3. Section 4.9.3, “Search with saved queries”

4.9.1. Quick Search

With the quick search, you can directly type a search term in the search field. All documents whose

keywords match the search term are retrieved and listed in the Search results form.
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1. Enter a search string into the search text box.

2.
Click the  icon to perform the search.

Search results will be displayed in the right pane.

The search results will be empty if no document contains the search string.

3.
Click the  icon to view the content containing the search string.

Or click the  icon to go to the node that contains the search result.

4.9.2. Advanced Search

To perform an advanced search:

1.

Click the  icon.



Chapter 4. Basic Actions

162

2.
Then click the Advanced Search  icon to open the Advanced Search form.

The Advanced Search form will open:

The tabs in this form offer different search functions:

• Section 4.9.2.1, “Search by Name”

• Section 4.9.2.2, “Search with constraints”

• Section 4.9.2.3, “Search by creating a new query”

• Section 4.9.2.4, “Search by existing queries”

4.9.2.1. Search by Name

Use the Search by Name tab to search nodes by name:

1. Enter the exact name you wish to search in the Content name field.

2. Click Search.

Results will return with the message “No result found” if there is no node with the specified

name.

Results will be returned in the Search Results tab if the requested name is found.

4.9.2.2. Search with constraints

This search enables you to search with more constraints to limit the returned results.
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Extra search constraints are entered in the Advanced Search tab of the Advanced Search form.

The Current location field is not editable; it shows the path selected to search.

Procedure 4.91.

1. Enter search terms in the A word or phrase in content field.

2. Select the Operator.

• Select the AND operator to only return results that meet both the search terms and the

entered constraints (see Step 3).

• Select the OR operator to return results that meet either the search terms or the entered

constraints (see Step 3).

3. Click Show/hide constraints form to add more constraints.

A further constraint options window will appear:
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Table 4.25.

Item Details

1 You can add more than one constraint with

either of two operators (AND and OR).

2 These fields allow you to add a constraint to

search by a property with specific values.

3 These fields allow you to add a constraint to

search by a property that contains one of the

word in the specific string.

4 These fields allow you to add a constraint to

search by a property that does not contain

the specific string.

5 These fields allow you to add a constraint

to search by a duration of date (created,

modified).

6 This field allows you to add a constraint to

search by a document type, including File,

Article, Podcast, Sample node, File Plan,

Kofax).

7 This field allows you to add a constraint to

search by categories.

Add a document type.

Add a category.

4. Select the constraint operator(AND/OR).

5. Add the required constraints using one of the following methods:

1. Add a constraint for exact values

2. Add a constraint including or excluding values

3. Add a constraint by date

4. Add a constraint by document type

5. Add a constraint by category
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Procedure 4.92. Add a constraint for exact values

1. Check the box that corresponds to the constraint you want.

2.

Enter the property you want to locate or click the  icon.

A list of possible properties appears:
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3. Select a property from the list and click Add. The selected property will populate

Properties field.

4. Define the property value to search for by entering

a value into the Contain exactly field or click the

icon.
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The Filter form will appear:

All pre-existing values for the property you selected will appear.

• If the value you require is in the list, select it and click Select.

•

If the value you require is not in the list, enter it in the Filter: field and click the 

icon. The value will populate the Contain exactly field of the constraints form.
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Procedure 4.93. Add a constraint including or excluding values

1. Check the box corresponding to the Contain or Not Contain constraint, as appropriate.

2. Enter the required property in the Property field or click the

icon (refer to Step 2 in Add a constraint for exact values for more information).

3. Enter the required values in the Contain or Not Contain fields.

Procedure 4.94. Add a constraint by date

1. Click the check box beside the field with the drop-down menu (below the Property

entries).

2. Define the search condition from the drop-down list (CREATED/MODIFIED).

3. Click in the From field.

A small calendar will appear;
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Select the date you want to use as a constraint.

4. Repeat the above steps for the To field.

The selected dates will populate the From and To fields in the Add constraint form.

Procedure 4.95. Add a constraint by document type

1. Click the checkbox beside the Document Type field.

2.

Enter the document type you want to search for or click the  icon to open a list of

document types:
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3. Click the checkbox of the document type you want and click Save.

The selected document type will populate the Document Type field.

Procedure 4.96. Add a constraint by category

1. Click the checkbox beside the Category field.
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2.
Enter the category you want to search for or click the  icon for a list of categories:

3.
Click the  that corresponds to the category you want.

The selected category will populate the Category field.

6. Click Add to add any/all activated constraints.

The constraints will be converted to an SQL query and displayed in the search form:
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Remove unnecessary constraints with the  icon.

7. Click Search to launch the search. Results will be displayed in the Search Results tab.

8. Click Save and put a name for this search configuration if you want to save it to use at another

time.

4.9.2.3. Search by creating a new query

You need a knowledge of the structure of query statements in order to configure a search using

the parameters on the New Query tab.

1. Enter a unique name for this query in the Name field.

2. Choose a query type from the drop-down menu; SQL or xPath.

3. Enter a query statement.

4. Click Search to perform the search and display the results in the Search Results tab.

Or click Save to save the search query to the Saved Query tab.

Or click Cancel to quit.

4.9.2.4. Search by existing queries

This tab lists all saved search queries (that you have access rights to use).
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•
Click the  icon to perform the search and see the results in the Search Results tab.

•
Click the  icon to edit the query statement. The query form will appear like when creating

a query (see Section 4.9.2.3, “Search by creating a new query”); however, you cannot edit the

name of the saved search.

•
Click the  to delete a query (provided you have the access rights to that query).

4.9.3. Search with saved queries

Do the following to perform a search with saved queries:

1.

Click the  icon to see the list of existing queries.
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A query list will appear. It contains the sections, including All Articles, Created Documents,

CreatedDocumentDayBefore and allArticles.

2. Launch, modify or delete the queries as required (see Section 4.9.2.3, “Search by creating

a new query” for more information).

3. Filter results with the entries in the All Items and/or By Type panes on the left of the tab.

Items matching the selections will appear in the right pane.

4. Click the required document or folder name to view or download them.

4.10. Preferences

This function is used to set up your browsing preferences.

Procedure 4.97.

1.

Click the  icon on the right side of the Content Explorer portlet.

The Preference Setting window will appear:
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Table 4.26.

Setting Details

Sort by To sort nodes in the nodes list by Alphabetic,

Type, Created Date, or Modified Date

Show sidebar To display/hide the sidebar.

Enable drag and drop To enable/disable the “drag and drop” action.

Nodes per page This number of nodes that will be displayed

per page.

Show non document nodes To display/hide nodes that are non–

documents.

Show referenced documents To display/hide referenced documents.

Show hidden nodes To display/hide hidden nodes.

Query Type This query type.

Enable DMS structure To display/hide nodes in a document in tree

structure.

2. Configure the preferences as required and click Save to set them.

Or click Back to quit without submitting changes.

4.11. Search Porlet

The Search function allows you to quickly search for any contents in the system with a keyword

from the front page, even if you do not log in. However, the number of the search results displayed

depends on your role.

For example, if you do not log in, you only see the search results that are published.
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4.11.1. How to search for contents?

To search for contents, do the followings:

1. Enter a keyword into the search box and press Enter.

The search results matching with your keyword are displayed in the search page:

In case of no search results matching the keyword, the search page is displayed as below:

Details of the Search form:

Table 4.27.

Field Details

Keyword The keyword used to search.

Portal The scale where you want to search. You

can search in all portals or in a specific portal.

Page Search in all pages containing the keyword.
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Field Details

Document Search in all documents containing the

keyword.

2. In the Search form, you can enter another keyword in the Keyword field and set the the

search scale.

3. Click Search to start searching.

4.11.2. Edit the Search portlet

Editing the Search portlet allows you to change the display of search results.

Do the followings:

Procedure 4.98. Edit the Search portlet

1. Open the Search page as Section 4.11.1, “How to search for contents?”.

2. Open the form to edit the Search portlet

There are two ways:

•
The 1st way: Turn on the Edit mode, and then click the  icon:

• The 2nd way: Click Site Editor → Edit Page on the administration bar. The Page Editor

will be displayed.

• Hover the mouse pointer over the SearchResult portlet and the toolbar appears:
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•
Click the  icon to edit the portlet.

The form to edit the Search portlet appears:

Details:

Table 4.28.

Field Details

Items per page The number of search results displayed in

each page.

Page Mode The way to display the search results. There

are 3 options:

• None: Only the first page of search results

is displayed in the search page.

• More: When you click the Search button,

the first page of search result is displayed.

The difference from the None mode is
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Field Details

that, there is a More button allowing

you to see more search results. When

clicking this button, new search results

are appended to the current search result

page like Twitter or Facebook behavior.

• Pagination: In this mode, the search

results are divided into many pages (for

example, 1, 2, 3 and Next). You can

navigate to another page by clicking the

page number or Next in the bottom of the

Search portlet to view more results.

Search form template The template of the Search form.

Search result template The template for displaying the search

results.

Search page layout template The layout of the Search portlet.

Base path The page where you can see the content of

a search result.

3. Edit your desired portlet and click Save to accept your changes.

4.12. Newsletters

eXo Content provides a newsletter service aimed at helping users quickly get updated news from

a website.

4.12.1. Newsletter Viewer

With Newsletters, you can instantly get newsletters from your email to update the last information

about categories and subscription.

Do the following to subscribe to newsletters:

1. Go to Newsletters on the navigation bar. The Newsletters page will appear:
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2. Enter your email address in the Your Email field.

3. Select the checkbox corresponding to the subscription that you want to get newsletters.

4. Click Subscribe. A message informs that you have just subscribed to the selected newsletter

will appear.
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5. Click OK in the confirmation message. You can reselect the subscription that you want or

do not want to receive newsletters by re-selecting the checkbox in the Check to subscribe

column.

6. Click Change your subscriptions to update your changes.

7. Click Forget this email if you want to unsubscribe from newsletters.

4.12.2. Manage Newsletters

eXo Content allows administrators to easily and quickly manage newsletters. Go to Group →
Newsletters on the administration bar to access the Newsletters functionality.
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4.12.2.1. Category Management

Administrators can manage the categories that newsletters are distributed under.

4.12.2.1.1. Add a new category

Procedure 4.99. Add a new category

1. Click New Category on the action bar of the Newsletters page. The Category form will appear.

Table 4.29. Category Form Field Details

Field Description

Name The name of a category. This field is

required.

Title The title of a category. This field is required.

Description A brief description of the category.

Moderator Select users/groups who have rights to

manage this category.

Save Accepts the addition of a new category.

Cancel Quits the category form without adding a

category.

2. Input values for fields

a.
Select a moderator for a category by clicking the  icon next to the Moderator field to

select a user. The form to selet users will appear.
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b.
Click the  corresponding to the user in the list that you want to select.

c.
Click the  icon to select users in a specific group. The Group selector will appear.

Select a group from the left panel and a membership type in the right panel. The

membership and group selected will be displayed in the Moderator field. After adding

new categories, they will be added in the list of categories.

After creating a category, you can create new subscriptions or newsletters for this category.

When you click the Administration button, you will see a drop-down menu consisting of all

actions on this category.

4.12.2.1.2. Edit a category

1. Select a category that you want to edit and click Administration → Edit Category in the

drop-down menu to bring up the Category form.
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2. Change the values in the Title and Description fields as required (Note that you cannot

change the name of the category).

3. Click Save to save all changes.

4.12.2.1.3. Delete a category

Procedure 4.100. Delete a category

1. Click Delete category in the menu. A confirmation will appear:

2. Click OK to delete the category or Cancel to exit without deleting.

4.12.2.1.4. Manage Users

Administrators can manage users accounts and activity with edit, ban, remove ban or delete

actions.

Procedure 4.101.

1. Click Administration → Manage Users in the menu. The Manage Users form will appear:
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Table 4.30.

Field Details

Email The email address of user who has

subscribed this subscription.

Banned This field has two values:

False

The user is allowed to get email.

True

The user is not allowed to get email.

To ban this user from receiving email.

To remove a ban on a user.

To delete the user.

2. Click Close to close the form.

4.12.2.2. Subscriptions

An administrator can add more subscriptions to any category. There are two ways to do this:

Procedure 4.102. Method One:

1. Click New Subscriptions on the action bar.

The Subscription form will appear:
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Table 4.31.

Field Details

Category The category that contains this subscription.

Name The name of the subscription. This field is

required.

Title The title of the subscription. This field is

required.

Description The brief description about the subscription.

This field is not required.

Redactor Select users/groups who have rights to

manage this subscription This field is

required.

2.
Click the  icon and select the category from the drop-down menu.

3. Enter the rest of their values in the form.

4. Click Save to create the new subscription or Cancel to quit without creating a new

subscription.

Procedure 4.103. Method Two:

1. Click directly on the category to which you want to create a new subscription:
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2. Click New Subscriptions on the action bar.

The Subscription form appears:

Follow the same steps as Method One.

Administrators can create newsletters for each subscription.

These Newsletters can be opened, edited, deleted or converted to a template for reuse.

Table 4.32.

Element Details

Shoes The name of the subscription.

Fashion Shoes The brief description about the subscription.

Letter The list of all letters of this subscription.
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Element Details

Date The date and time when creating this letter.

Status There are three types of status: draft, awaiting

and sent.

Moderation This button allows you to take actions on a

newsletter that you select.

4.12.2.3. Open a Newsletter

Administrators can easily view the content of a newsletter.

Procedure 4.104.

1. Choose a category by clicking it or checking the box and then selecting Administration →
Open.

2. Select the newsletter that you want to open by clicking it or selecting the checkbox.

3.

Click the  button then select Open in the menu:
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The View Newsletter's Content form appears:

4. Click Close to exit.

4.12.2.4. Edit a newsletter

Do the following to edit a newsletter.

Procedure 4.105. Edit a newsletter

1. In a specific subscription, select the newsletter you want to edit by selecting the checkbox.

2.

Click the  button then select Edit in the menu.

The Newsletter entry form appears:
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3. Change the values in the fields that you want to edit: Template, Send date, Category,

Subscription.

4. Click the Update a Newsletter's info button.

5. Change the values in the fields Title and Main content.

6. Click Save to save as a draft or click Send.

4.12.2.5. Delete a newsletter

Administrators can delete obsolete newsletters.

Procedure 4.106. Delete a newsletter

1. In a specific subscription, select the newsletter that you want to delete by selecting the

checkbox.

2.

Click the  button then click Delete in the menu.
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A confirmation message will be displayed:

3. Click OK to accept deleting this newsletter or Cancel to quit without deleting.

4.12.2.6. Convert as Template

Administrators can reuse a popular newsletter template.

Procedure 4.107. Convert to template

1. Select the newsletter that you want to create as a template.

2.

Click the  button then select Convert as Template in the menu. The next

time when you create a newsletter, this template will be listed in the Template field of the

Newsletter entry form.

4.12.2.7. Newsletters

Each subscription consists of many newsletters. eXo Content helps you easily create newsletters

by following these steps.

Procedure 4.108. Creating Newsletters

1. Go to Group → Newsletters on the administration bar. The Newsletter portlet appears.

2.

Click the  button on the action bar. The Newsletter entry form

appears:
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Details:

Table 4.33.

Field Details

Template The template for your newsletter form. Basic

Template is set by default.

Send date The date and time to send the newsletter.

Category The category contains this newsletter.

Subscription The subscription contains this newsletter.

Update sending parameters This button allows you to update information

about this newsletter.

3.
Click the  icon to select the template for the newsletter.

4. Click the Send Date field. The calendar will appear to allow you to choose the date and time

when you want to send the newsletter.
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5.
Click the  icon in the category field to select the category and the subscription in list.

6. Click the Update sending parameters button to update information about this newsletter. A

message pops up and informs you that you have updated information successfully.

7. Input a title for the newsletter into the Title field.

8. Create a content for a newsletter by inputting information into the Main content text box.

9. Click Save to save this newsletter as a draft or click Send to send this newsletter.

10. Select Contact Us on the navigation bar or go to Site → Acme → Contact Us.

The Contact Us page appears:
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Table 4.34.

Field Details

Select a recipient The recipient who will receive a message

Your name The name of a person who leaves a

message

Your address The address of a person who leaves a

message

Your Email Address The email address of a person who leaves a

message

Your Phone Number The phone number of a person who leaves

a message

Your message Write a message that you want to leave

11. Select a recipient and enter values in this form.

12. Click Save to save a message.

4.13. Fast Content Creator

The Fast Content Creator portlet in eXo Content allows you to quickly create and save a new

document with only one template in a specific location without having to access Content Explorer.

This can dramatically expedite the creation of a single new document.

There are two modes in Fast Content Creator: Basic Content Creator and Standard Content

Creator.
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The Standard Content Creator mode adds an Actions section to the Edit Mode tab (see the

details at Section 4.13.1, “Configuration”) which allows you to add an action to your document

when configuring it.

To add an action to a document, click Add or the

icon to open the Add action form. Follow the procedure in Section 4.7.4.10.1, “Add an action”.

4.13.1. Configuration

In eXo Content, the Fast Content Creator is applied in the Contact Us portlet with the Basic

Content Creator mode by default. You can configure the Fast Content Creator by editing the

Contact Us portlet.

To configure the Fast Content Creator, do the following:

1. Go to Contact Us on the Navigation bar or go to Site → Acme → Contact Us

2. Click Site Editor → Edit Page on the administration bar. The Page Editor will be displayed.

3. Hover the mouse pointer over the Contact Us portlet and the toolbar appears.

Click the

icon to edit the portlet.



Chapter 4. Basic Actions

196

The form with the Edit Mode tab appears:

Table 4.35.

Field Details

Location to save Select the location to save documents or

messages.

Select template Select a document template. There are

different input fields corresponding to each

template.

Custom save button Change the label for the save button.

Custom save message Show a custom message that informs you

have just saved a document.
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Field Details

Redirect Allow you to redirect the path in the Redirect

path field.

Redirect path Show a path to which you will be

directed after clicking OK in the confirmation

message.

4. Select the location to save:

a. Click the

icon to select a specific location to save documents. The Select Location form appears:

b. Select the parent node on the left panel and click the

icon in the Action column to choose the child node on the right panel. After being

selected, this location will be displayed on the Location to save field. Created

documents will be saved in this location.

5. Select a template which is used to create a new document.

6. Change the label for the Custom save button, and the content for the Custom save

message.

7. Tick the Redirect checkbox if you want to redirect to the path in the Redirect path field after

clicking OK in the save message.

8. Click Save to finish the configuration of the Fast Content Creator portlet.
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9. Click OK in the confirmation message.

10. Click Close to quit the form.

4.13.2. Create a new document

To create a new document with the Fast Content Creator, do the following:

Procedure 4.109. Create a new document

1. Go to Site → Acme → Contact Us.

2. Enter values into all the fields in the Contact Us portlet.

3. Click Save to accept creating the new document. A message appears to let you know that

the document is created successfully at the location that you established in the location to

save field.

4.13.3. View a new document

After creating a new document, you can view it by do the following:

Procedure 4.110.  View a new document

1. Go to Content Explorer.

2. Select the drive and the path that you established in the configuration of Fast Content Creator

to view the new document.

4.14. Form Builder

The Form Builder portlet enables users to create and to edit various document type templates.

Documents are stored in a node; therefore, the term node and node types are often applied.

Procedure 4.111.

1. Go to Group → Form Builder on the administration bar. The Form Builder will appear:
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2. Enter the node name into the Name field (an asterix [*] indicates that this a required value).

3. Enter a brief description of the node.

4. Click the Form Builder tab. Items on this tab allow you to set properties for a node. Available

components are displayed on the left pane.

5. Click the desired components on the left pane. The selected components will be displayed

on the right pane.

6.
Click the  corresponding to the component to move this component up or the  to move

the component down.
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7.
Click the  icon that corresponds to the component to edit properties of that component.

The form to edit properties appears like the illustration below:

Table 4.36.

Field Details

Field Label To enter the field label.

Width To enter the field width. If the

 checkbox is

marked, the  will appear beside the text

box, indicating that values in this box are

required.

Height To enter the field height.

Default Value To display the default value

Guidelines for User To display instructions about this

component.

To delete the component, click the  corresponding to the component.

Click the  icon again to hide the form to edit the properties.

After editing the properties of the components, the components will appear similar to the

illustration below:



Category Navigation

201

8. Click Save to create the new node, or Reset to edit the node again before saving.

A message will inform that you created a node successfully.

4.15. Category Navigation

The Category Navigation Portlet and Parameterized Content List Viewer portlets avoid the need

for long URLs when viewing a content and enable users to see published documents or web

contents in specific categories in one page.

Using symbolic links, the database can retrieve the content no matter where the object physically

resides. The relations between shortcuts can also be managed in this way.

Procedure 4.112. Access to Category Navigation Portlet

1. Go to News on the navigation bar:

The left pane lists all the categories containing contents.
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The right pane displays all the documents belonging to the current category.

2. Click a category that you want to view its contents. Its sub-categories are listed on the left

pane and its contents are shown on the right pane.

3. Click Go to previous to return to the parent category.

The Edit Mode of the Category Navigation Portlet.  Administrators can edit the Category

Navigation portlet with the following procedure:

Procedure 4.113.

1. Go to Group → Administration → Manage Pages on the administration bar. The Manage

Pages list will appear:

2.
Click the  icon in the Category navigation portlet entry to open the page to edit this portlet.
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3.
Click the  icon to open a form to edit the portlet settings.

4.
Click the  to select the repository for documents in the Repository field.

5. Enter the name of a category in the Title field.

6. Select the tree name for a category.

7. Select the template for displaying categories.

8.
Click the  icon to select the target path. The Page Selector form will appear:
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9.
Click the  to select the navigation on the left pane. The corresponding pages will be

displayed on the left pane and the corresponding paths will be displayed on the right pane.

10.
Click the  icon to select the path. This path will be displayed in the Show in Page field

of the Edit Mode tab.

11. Click Save to accept saving the configuration for the Category Navigation portlet.
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Advanced Actions

5.1. Manage Site Resources in one place

You can easily manage all the site resources in Content Explorer.

Chose  in a General drive. All of your created sites and their resources

will be listed in the left panel.

All sites contain typical folders that are site resources:

5.1.1. CSS Folder

CSS is one of the default files of a site. This folder contains CSS data that is used to present

content data in a site and increase that site's accessibility.

CSS

Once a new CSS file is created in a site, it will affect how the site is displayed.

For example, if your new CSS file is created with a red background color, the site

background will then turn to red.
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5.1.2. Document Folder

This folder contains all documents used in a site. When you want to add a new document for a

site, you can also put them in another folder, but it is recommended to use this one to manage

everything easily and conveniently.

5.1.3. JS Folder

This is one of the default files of a site. This file contains Java Script data that is used to make

a site more animated and more dynamic.

5.1.4. Links Folder

This file contains all links used in a site.

5.1.5. Media Folder

This folder contains all documents related to videos, images and sounds. It is divided into three

sub folders:

audio:

This folder contains sound data used in a site.

images:

This folder contains images used in a site.

videos:

This folder contains videos used in a site.

5.1.6. Web Content Folders

This folder contains all web content used in sites. It is recommended to put all the web contents

files here to manage them more easily, or for easy reuse in another site.
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5.2. Administration Page

This page is used to manage all workspaces, drives, node types, metadata, templates, queries,

etc. Only administrators can access the Administration page.

• Click Group → Administration on the administration bar:

The Administration page will appear:
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This page gives you to access to the following sub-pages:

• Categories and Tags: Manage Categories and Manage Tags.

• Content Presentation: Manage Template, Manage Metadata, Manage Views and Manage

Drives.

• Content Types: Namespace Registry and Manage Node Type.

• Advanced Configuration: Manage Queries, Manage Scripts Create an Action Type and

Manage Unlocks.

5.2.1. Categories and Tags

5.2.1.1. Manage Tags

The Manage Tags form allows you to manage tag styles (the appearance of tags in visual

representations). A tag's style changes depending on the number of documents with that tag.

Go to Group → Administration then click on Categories and Tags → Manage Tags.

From this page you can add new tags styles or edit existing styles.
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5.2.1.1.1. Add a tag style

To add a new tag style, do the following:

Procedure 5.1. Add a Tag Style

1. Click the Add style button. The Add tag style configuration form will appear:



Chapter 5. Advanced Actions

210

Table 5.1.

Field Details

Style name Give the tag name. You cannot edit it.

Document Range Give the number of documents that must

have this tag for this style to apply. The

asterix (*) indicates this is a required value.

HTML style Include settings for the font-size, font-weight,

color, font-family and text-decoration. The

asterix (*) indicates this is a required value.

2. Input values in the fields: Style name, Document range, HTML style, all of which are

required.

3. Click Update to accept adding a new tag style.

Note

• The format of valid range must be: a..b where a, b are positive integers. You can

use * instead ofb to indicate it is unlimited.

For example; 0..2 means that 0, one or two documents must be assigned to a

tag for this style to apply while 10..* means at least ten documents (with no upper

limit) must be assigned for the style to take effect.

• The HTML style text box cannot be empty: you can change values of font-size,

font–weight, color, font-family, text-decoration.

5.2.1.1.2. Edit

To edit the existing tags do the following:

Procedure 5.2. Editing existing tabs

1. Click the pencil icon corresponding to the tag name which you want to edit in the Action

column. The Edit tag style configuration form appears like the form to add a tag style.

2. Change values in the fields Document range and HTML style. Do not change the Style

name field, as you are editing an existing tag.

3. Click Update to save any changes.
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5.2.1.1.3. Delete a tag style

To delete a tag style:

Procedure 5.3.

1. Click the corresponding trash icon,

2. Click OK in the confirmation message to confirm the deletion.

5.2.1.1.4. Tag Permission Manager

The Tag permission manager tab helps you set permissions regarding editing and deleting public

tags.

Procedure 5.4. Set Permission To Tag Management

1.
Click the  icon beside the Memberships field to select memberships in order to add a

permission for those memberships. The Select membership form will appear:
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2. Select a group on the left and the corresponding membership on the right. The selected

membership will appear in the Memberships field:

3. Click Save to add a permission for the membership to the Memberships column.

To delete memberships permissions:
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Procedure 5.5.

1. Click the trash icon corresponding to that membership.

2. Click OK in the confirmation message.

5.2.1.2. Manage Categories

Category management can be understood as a classification practice. Categories are used to sort

documents, so as to facilitate effective searches.

In this section, the concept of categorization and classification will be referred to with the term

taxonomy.

The eXo Content category management system includes adding, editing and deleting a taxonomy

tree.

Go to Group → Administration then click on Categories and Tags → Manage Categories.

The Manage Categories form appears.

5.2.1.3. Add a Taxonomy Tree

1. Click the Add Taxonomy Tree button to add a new taxonomy. The Add taxonomy tree form

will appear.
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2. Enter a name for the tree in the Name field. The asterix (*) denotes this as a required field.

3. Select the workspace you want to work with.

4. Select the home path by clicking the plus icon. The Select Home Path form will appear:

5. Click the tick icon if you want to select the root path or click the arrow icon to go to the up

level path. Click the plus sign to expand the folder.

6. Click the tick icon corresponding to the path that you want to select as a home path.
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Click Reset if you want to reset values that have just been selected or Next to select

permissions for a taxonomy tree.

7.
Click the  icon to select a user, the  icon to select memberships or the  icon to

select everyone in order to set permissions. The user or membership that you have selected

will be displayed in the User or Group field.

Then, check at least one of the options below to set rights for the selected user to membership:

Read Right

The option is to select the Read right or not.

Add Note Right

The option is to select the Add Node right or not.

Set Property Right

The option is to select the Set Property right or not.

Remove Right

The option is to select the Remove right or not.

8. Click Save to save all values, or Reset to change values that have just been set.

9. After clicking Save, click Next to go to the next step.
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10. Enter the name for an action of the taxonomy tree in the Name field. This is a required (*)

value.

11. Select values for Life-cycle, NodeTypes, Target workspace, Target path, Affected Node

Types. These fields are required (*).

12. Click Save to save all values and click Next to go to the next step.

Considerations

• Do not use the following special characters in the Name field like: !,@,#,$,%,&,*,

(,).

• Do not add a taxonomy which has the same name and level with existing

taxonomies in a node.

• The taxonomy name must contain fewer than thirty (30) characters.

5.2.1.4. Edit a Taxonomy Tree

To edit a taxonomy tree:

1.
Click the  icon that corresponds to the taxonomy tree you want to edit.
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2.

Click the  icon in the Action field to add more taxonomy trees. The Edit taxonomy tree

will appear:

3. Enter a taxonomy name in the Taxonomy name field. This field is required (*).

4. Click Saveto save the taxonomy name.

5. Click Previous to return to the previous steps.

6. Click Save to save all changes and the Previous or Next if you want to edit more.

Considerations

• You can delete a taxonomy by clicking the trash icon corresponding to the

taxonomy that you want to delete. Click OK on the confirmation message to

accept deleting this taxonomy, or click Cancel to discard this action.

• You cannot delete taxonomies that have been referenced.
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5.2.2. Content Presentation Manager

5.2.2.1. Manage a Template

When creating a node in eXo Content, you must set its properties. Therefore, each node needs

to have a form to enter data for their properties (called the dialog template), and display the

existing values (called the view template).

The Template Management system allows users to view, delete or modify the predefined

templates or to add a new template.

Procedure 5.6. Add a New Template

1. Go to Group → Administration then click Content Presentation → Manage Templates.

2. Click the Add button in the Manage Templates form to open the Template form.

3. Select the template type you require from the Name drop-down menu.

4. Specify a name for the template in the Label field.

5. Click the Document Template check box if the template you are creating should be used

as a template for a document.

6. Click the icon next to the Permissions field to open the Select Permission dialog.

7. Select a group from the left panel and the membership from the right panel. Alternatively you

can set permission for everyone by clicking the icon next to Any Permission
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8. Select the Dialog tab and enter the value in the Dialog content field.

9. Select the View tab and enter the value in the Dialog content field.
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10. Select the CSS tab and enter the value in the Dialog content field.

11. Click the Save button to create the template.

Procedure 5.7. Edit a Template

1. Go to Group → Administration then click on Content Presentation → Manage Templates.

2.
Click the  icon in the Action column corresponding to the template you want to edit.

3. In the Template tab, you can edit the Label of the Template.

4. To add a dialog, do the following:

a. Enter content for this dialog in the Content field.

b. Enter a name for this dialog. This value is required (*).

c. Select permissions for a group that can use this dialog. This value is required (*).

5. To edit an existing dialog, do the following:
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a.
Click the  icon in the dialog row you want to edit.

b. Edit the dialog properties.

c. Click Save to accept all changes in the Dialog tab.

6. To delete an existing dialog, do the following:

a.
Click the  icon in the dialog row you want to edit.

b. Click OK to continue with deletion.

Note

You cannot delete the default dialog. You must create a new one before you

can delete the current default dialog.

7. To add a view, do the following:

a. Click the View tab and enter content into the content field.

b. Enter a name for this view. This field is required (*).

c. Select permissions for a group that can use this view. This field is required (*).

8. To edit an existing view, do the following:

a.
Click the  icon in the view row you want to edit.

b. Edit the view properties.

c. Click Save to accept all changes in the View tab.

Notes about Editing Views

You cannot change the view name.

If you click Enable Version checkbox, this view automatically increments one

version after you click Save. It is displayed at version column in the View tab.

If the dialog has at least two versions, in the View tab, it displays the Restore

button. You can use Restore to roll back to the previous View.
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9. To delete an existing dialog, do the following:

a.
Click the  icon in the dialog row you want to edit.

b. Click OK to continue with deletion.

c. Click Save to accept all changes.

Procedure 5.8. Delete a Template

1.
Click the  corresponding to the template that you want to discard.

2. Click OK on the confirmation message to delete the template or Cancel to abort the operation.

5.2.2.2. Metadata Management

Metadata in its simplest form is "data about data". Generally, it may be understood as information

that describes, or supplements the central data.

Metadata management allows managing nodes in the metadata format in the eXo Content system.

The metadata may be considered as information used to describe the data. When data are

provided to the end users, the metadata allow users to understand about information in more

details. All metadata nodes can combine with other nodes to create a new node (add mix).

Procedure 5.9. View Metadata

1. Go to Group → Administration then click Content Presentation → Manage Metadata.

2.
Click the  icon corresponding to the metadata you want to view.

The Metadata Information Form opens.
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Procedure 5.10. Edit Metadata

1.
Click the  icon in the metadata row you want to edit.

The Edit Metadata's Template form opens.

2. Change the required properties of the metadata.

Metadata Name

You cannot edit the metadata name.

3. Click Apply to save all metadata changes.

Procedure 5.11. Delete Metadata

1.
Click the  icon corresponding to the metadata you want to delete.
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A confirmation message appears.

2. Click OK to delete the template, or Cancel to preserve the template.

5.2.2.3. Manage Views

The Manage Views function is used to control view ways of a user. It has three tabs: View, ECM

Templates and BC Templates tabs.

To open the Manage View function, go to Group → Administration then click on Content

Presentation → Manage View. The Manage View form opens.

Views Tab.  On the Views tab you can add, edit, delete or preview views.

Procedure 5.12. Add View

1. Click the Add View button located at the bottom of the Manage View form.

The Add View form opens.

2. Specify the name of the view you are creating in the Name field. The name must be unique,

and must only contain standard alphanumeric characters.
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3. Select the group from the left panel and the membership from the right panel.

4. Click the Templates field and select the correct template for this view.

5. Click Save to apply all settings and close the form.

Procedure 5.13. Edit a View

1.
Click the  icon in the view row you want to edit.

2. Edit the view properties.

Notes about Editing Views

You cannot change the view name.

If you click the Enable Version checkbox, this view automatically increments

one version after you click Save. It is displayed at version column in the View

tab.

If the dialog has at least two versions, in the View tab, it displays the Restore

button. You can use Restore to roll back to the previous View.

3. Click the Add Tab button to open the Tab Form tab to add more tabs.

a. Click the Add Tab button to add more tabs after the initial tab has been added.

b. Click the Reset button to apply changes.
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c. Click the Back button to return to the View Form tab in the Edit View form.

4. Click Save to apply all changes in the View tab.

Procedure 5.14. Delete Views

1.
Click the  icon corresponding to the view you want to delete.

A confirmation message is displayed.

2. Click OK to delete the view.

Deleting the Current View

You cannot delete a view that is currently in use.

Procedure 5.15. Preview a View

1.
Click the  icon in the Action column of the view you want to preview.

The View Form opens:

2. Click Close to exit the View Form.
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5.2.2.3.1. ECM Templates

Procedure 5.16. Add a new ECM Template

1. Select the ECM Templates tab.

2. Click the Add button to open the Add ECM Template form.
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3. Enter the content of the template in the Content field.

4. Enter a name for the template in the Name field.

5. Select a type for the template in the Template Type field.

6. Click Save to accept adding a new template, or click Reset to change values, or Cancel to

quit without any changes.

Procedure 5.17. Edit a Template

1.
Click the  icon next to the template you want to edit.
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2. Change the current template's properties.

3. Click Save to accept all changes.

Template Names

You cannot edit the template name.

If you tick the Enable Version checkbox, this template will automatically

increase to one version after you have clicked Save. It is displayed at the Base

version column in ECM template tab.

If the template has at least two versions, in the Edit ECM Template form, it

displays the Restore button that allows restoring the template version.

Procedure 5.18. Delete a Template

1.
Click the  icon corresponding with the template you want to edit. A confirmation message

will appear.

2. Click OK to accept deleting this template.
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5.2.2.3.2. BC Templates

Procedure 5.19. Adding a New Template

1. Click Add to open the Add BC Template form.

2. Enter the content for the template in the Content text box. This field is required (*).

3. Enter the name for the template in the Name field. This field is required (*).

4. Select the template type from the drop-down box in the Template Type form.
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Note

The name must be unique.

The name must not contain special characters like !,@,#,$,%,&,*,(,).

5. Click Save to complete adding a new template.

Procedure 5.20. Edit a BC Template

1.
Click the  icon on a template that you want to edit.

2. Change the current template's properties.

3. Click Save to accept all changes.

Uneditable Fields

You cannot edit the template name.
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You cannot edit the template type.

If you tick the Enable Version checkbox, this template will automatically

increase by one version after you have clicked Save. It is displayed at the

Base Version column in ECM Template tab.

If the template has at least two versions, in the Edit ECM Template form, it

displays the Restore button that allows restoring the template version.

Procedure 5.21. Delete a Template

1.
Click the  icon corresponding with the template you want to edit. A confirmation message

will appear.

2. Click OK to accept deleting the template, or Cancel to discard this action.

5.2.2.4. Drives Management

The function supports to manage drives in the File Explorer. It allows adding, editing and deleting

drives.

Go to Group → Administration the go to Content Presentation → Manage Drives.

5.2.2.4.1. Add a new drive

1. Click the Add Drive button in the Manage Drives form to open the Add Drive form.
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2. Enter a name for the new drive in the Name field. This field is required (*).

3. Select a workspace for the drive. There are four available workspaces: system,

collaboration, backup, and dms-system.

4.
Select the home path for the drive by clicking the  icon beside the Home path entry.
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5.

Browse for an icon for the workspace by clicking the  icon beside the Workspace icon

entry.

6.
Select an icon by clicking the  corresponding to the desired icon file:

7.

Select permissions for groups that have access rights to this drive by clicking the  icon

beside the Permissions entry.

8. Select or deselect the various checkboxes to hide or show the corresponding drive elements:

Show referenced document

Allows viewing preference documents.
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Show non-document

Allows viewing non-documents.

Show sidebar

Allows showing the sidebar.

Show hidden node

Allows showing the hidden nodes.

9. Select the document type that will be created in this drive:

Folder

Only nt:folder folders can be created in this drive.

Unstructured folder

Only nt:unstructured folders can be created in this drive.

10. Select the Apply Views tab and select the view type you want to be available in the drive:

11. Click Save to commit the details and create the new drive, Refresh to clear the form or Cancel

to abort the operation.

5.2.2.4.2. Edit a drive

To edit a drive, do the following:
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Procedure 5.22. Edit a drive

1.
Click the  icon that corresponds to the drive you want to edit. The Edit drive form will

appear:

2. Edit the properties as required.

3. Click Save to commit the changes.

Drive Name

The drive name cannot be edited in this form.

5.2.2.4.3. Delete a drive

To delete a drive, do the following:

1.
Click the  that corresponds to the drive you want to delete.

2. Click OK on the confirmation message to delete the drive or click Cancel to abort the

operation.



Content Types

237

5.2.3. Content Types

5.2.3.1. The Namespace Registry

The namespace is a prefix in the node type name. It allows you to create node types without

potentially conflicting with existing node types.

The registry helps you manage the namespaces used in the system.

Go to Groups → Administration the click on Content Types → Namespace Registry to open

the Namespace Registry form.

Procedure 5.23. Registering a Namespace

1. Click the Register button on the Namespace Registry form to register a new namespace.

2. Enter a value for the Namespace Prefix field. This field is required (*).

3. Enter a value for the URI field. This field must be unique. This field is required (*).
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Special Characters

The namespace must not contain special characters like !,@,#,$,%,&,*,(,).

5.2.3.2. Manage Node Types

This function is used to control all node types in eXo Content.

5.2.3.3. View Node Types

1. Click the icon that corresponds to the node to be reviewed. The View Node Type Information

form will appear.
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2. Click Close to exit this form.

Procedure 5.24. Add Node Type

1. Open the Add/Edit Node Type Definitions form by clicking the Add button on the Manage

Node Type form.

Figure 5.1. Add Node Type Form
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2. Select a namespace for the node.

3. Enter a name in the Node type name field. This field is mandatory and its value must be

unique.

Special Characters

The name must not contain special characters like !,@,#,$,%,&,*,(,).

4. Select a value for the Is mixin type field.

• True: this node is mixin type.

• False: this node is not mixin type.

5. Select a value for the Orderable child nodes field:

• True: child nodes are ordered.

• False: child nodes are not ordered.

6. Enter a value for the Primary item name field.

7.

Super Types: Click the  button to add more parent types.

8. Property definitions: lists all definition names of Property tab.

9. Child node definitions: lists all definition names of Child node tab.

10. Click Save to accept adding a new node type, or Save draft to save this node type as a draft,

or Cancel to quit.

Procedure 5.25. Export Node Types

1. Open the Export Node Types form by clicking the Export button on the Manage Node Type

Form.
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2. Click Uncheck all if you do not want to export all node types. After clicking Uncheck all, this

button becomes the Check all button.

3. Select nodes that you want to export by ticking the checkboxes.

4. Click the Export button in this form.

5. Select the location in your computer to save the exported node.

Important

You must select at least one node type to be exported. If you do not want to

export the node, click Cancel to quit this pop-up.

Procedure 5.26. Import Node Types

1. Open the Import Node Type from XML file form by clicking the Import button on the Manage

Node Type form.
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2. Click the Browse button to upload a file.

Important

You must upload an XML file. This file is in the node type's format.

3. Click the Upload button.

Note

If you want to upload a different file, click the  icon to delete the file which

has just been uploaded, then upload other files.

4. Tick the checkboxes corresponding to the nodes that you want to import.

5. Click the Import button to complete importing a node type.

5.2.4. Advanced Configuration

5.2.4.1. Manage Queries

This function enables you to manage queries. It allows adding, editing and deleting queries.

Go to Administration → Advanced Configuration → Manage Queries.
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Procedure 5.27. Add a new query

1. Open the Add Query form by clicking the Add Query button in the Manage Queries form.
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2. Enter a query name for the Name field.

3. Select the query type:

Xpath

XML Path Language is a language for selecting nodes. For example, /jcr:root/

Documents/Live.

SQL

Structured Query Language is a database computer language.

4. Enter the statement for query. The name of node type must be unique.

5. Check or uncheck the Enable cache results option. If you tick this checkbox, for the fist time

you use this query to search, the result will be cached. For the second time you search using

this query, it will show the cached results. After 45minutes, the cache will be removed.

Example 5.1.

• You have the query Test with the statement //element (*, nt:file).
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• In the File Explorer, you have a nt:file document named File1.

• When you execute the query Test, only the File1 document will be shown.

• You create a nt:file document named File2 and execute query Test, only document

File2 document will be listed.

• After 45 minutes, the cache will be removed. When you execute the query Test, the

documents File1 and File2 will be listed.

6.

Select permissions for a group that can use this query by clicking the  icon.

7. Click Save to add the new query.

Procedure 5.28. Edit a query

1.
Click the  icon corresponding to the query you want to edit. The Edit Query form will

appear:
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2. Edit the properties of the selected query.

3. Click Save to submit any changes.

Procedure 5.29. Delete a query

1.
Click  icon corresponding to the query you want to delete. A confirmation message will

appear.

2. Click OK to accept deleting this query, or Cancel to discard the form.

5.2.4.2. Manage Scripts

The function enables users to manage all script codes in the ECM and Browser Content system.

Go to Group → Administration then go to Advanced Configuration → Manage Scripts.
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Table 5.2. Manage Scripts Form

Field Details

ECM Scripts These scripts are used in eXo Content.

BC Scripts These scripts are used in Content Browser.

Procedure 5.30. Add a new script in ECM

1. Select the ECM Scripts tab in the Manage Scripts form.

2. Click the Add button to open the Add/Edit script form:
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3. Enter a value for the Script content field.

4. Enter a name in the Script name field.

• The script name must be unique.

• The name must not contain special characters such as !,@,#,$,%,&,*,(,).

5. Click Save to adding the new script.

Procedure 5.31. Edit an ECM script

To edit an ECM script, do the following:

1.
In the ECM Scripts tab, click the  icon that corresponds to the script that you want to edit.

The Add/Edit script form will appear:
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2. Edit the properties in this form.

3. Click Save to save all changes.

Procedure 5.32. Delete an ECM script

To delete an ECM script, do the following:

1.
In the ECM Scripts tab, click the  icon on the script that you want to delete. A confirmation

message will appear.

2. Click OK to delete this script or Cancel to discard this action.

Procedure 5.33. Add a BC script

To add a BC script, do the following:

1. In the Manage Scripts, select the BC Scripts tab.
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2. Click Add to open the Add/Edit script form:

3. Enter the script in the Script content field.

4. Enter a name into the Name field.

5. Click Save to finish adding the new script.

Procedure 5.34. Edit a BC script

To edit a BC script, do the following::

1.
In the BC Script tab, click the  icon on a script that you want to edit.

The Add/Edit script form will appear:
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2. Edit the properties as required.

3. Click Save to accept all changes.

Procedure 5.35. Delete a BC script

To delete a BC script, do the following:

1.
In the BC Scripts tab, click the  icon on the script you want to delete. A confirmation

message appears.

2. Click OK to delete this script or Cancel to discard this action.

5.2.4.3. Manage Unlocks

All locked nodes are listed and managed by administrators in the Administration page.

There are two ways that administrators can unlock nodes:

1. The unlock nodes in the right-click menu of Content Explorer.

2. Manage Unlocks in the Administration page.
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Procedure 5.36. Manage Unlocks

1. Go to Group → Administration on the navigation bar. Then go to Advanced Configuration

→ Manage Unlocks.

2. In the Locked Node tab on the right panel, administrators can unlock nodes by clicking the

 icon that corresponds to nodes which need to be unlocked. The unlocked nodes will

disappear from the locked node list.

Administrators can manage and add the unlock permission for another group and users in

the Manage Lock tab.

3. Select the group on the left-hand Select group panel and the corresponding membership

on the right-hand Select membership panel. The selected group will be listed in the Group

and Users column. However, administrators can also click the  icon if they want to allow

any users to unlock nodes.
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4.
To remove the unlock permission of groups, click the  icon that corresponds to the group

in order to remove them form the Unlock permission list except the group *:/platform/

administrator and root.

5.2.4.4. Create Action Types

This function allows managing of all action nodes in the eXo Content.

Procedure 5.37. Create an Action Type

1. Go to Group → Administration on the navigation bar. Then go to Advanced Configuration

→ Create an Action Type.
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2. Click the Add button to open the Action Type Form form:

3. Select the action type.

4. Enter a name for the action.

5. Check or uncheck the is Action Move option: the action will have the exo:move property or

not depending on the status of this switch.

6. Select an execute for the Execute field.
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7. The Variables field allows creating multi-values for action. If you want to add more values for

action, click the  icon. Alternatively, click the  icon to delete a value.

8. Click Save to the new action type.
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Next Steps
While this User Guide is intended to provide a thorough explanation of features and terminologies

within eXo Content you may have more questions or want to get involved, the following links can

connect you with resources to learn more and contribute to the open source development process:

• Learn more about eXo Platform 3.0 [http://www.exoplatform.com/company/public/website/

platform]

• Video demos, tutorial and more in the eXo Resource Center [http://www.exoplatform.com/

company/public/website/resource-center]

• Access another eXo documents in the eXo Wiki [http://wiki.exoplatform.com/xwiki/bin/view/

Main/WebHome/]

• Ask question about eXo Content in the Forum [http://forums.exoplatform.org/portal/public/

classic/forum]

http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/platform
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://www.exoplatform.com/company/public/website/resource-center
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://wiki.exoplatform.com/xwiki/bin/view/Main/WebHome/
http://forums.exoplatform.org/portal/public/classic/forum
http://forums.exoplatform.org/portal/public/classic/forum
http://forums.exoplatform.org/portal/public/classic/forum
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Revision History

Revision 1-2.3 Wed Dec 15 2010 ScottMumford<smumford@redhat.com>

Exported company-specific content to separate files.

Revision 1-2.1.1 Fri Nov 19 2010 ScottMumford<smumford@redhat.com>

Updated docbook source to WCM 2.1.1

Revision 1-2.0 Mon Oct 25 2010 ScottMumford<smumford@redhat.com>,

LauraBailey, TomWells,

EslpethThorne,

RebeccaNewton, JaredMorgan

Completed docbook conversion.

Revision 1-0 Tue Sep 28 2010 ScottMumford<smumford@redhat.com>

Initial creation of book by publican
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